Accounting Feature for the Workstation

Version 1.6
IBM Tivoli® Decision Support for OS/390®

Accounting Feature for the Workstation

Version 1.6
Note
Before using this information and the product it supports, read the information in “Notices” on page 169.

Fourth Edition (June 2003)

This edition applies to version 1, release 6 of Tivoli Decision Support for OS/390 (program number 5695-101) and to all subsequent releases and modifications until otherwise indicated in new editions.

This edition replaces SH19-4516-02.

© Copyright International Business Machines Corporation 1999, 2003. All rights reserved.

Note to U.S. Government Users Restricted Rights—Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corporation.
Contents

Preface .............................................. v
Who Should Read This Book ....................... v
What This Book Contains .......................... vi
Publications ........................................ vi
  Tivoli Decision Support for OS/390 Library .... vi
Using LookAt to Look Up Message ................ viii
Explanations ....................................... viii
Accessing Publications Online ...................... ix
Ordering Publications ................................ ix
Accessibility ........................................ ix
Contacting Software Support ....................... ix
Conventions Used in This Book .................... ix
Typeface Conventions ................................ x

Chapter 1. Introduction ............................ 1

Chapter 2. Installing, Modifying,
Repairing and Removing the Product ............. 3
Program Requirements ............................. 3
  Workstation ...................................... 3
  File Server ...................................... 3
  Intranet Requirements ........................... 3
SQL Server Requirements ......................... 3
Installing the Accounting Workstation Option .. 4
Uninstalling the Accounting Workstation Option . 8
Modifying the Accounting Workstation Option ... 10
Installation ........................................ 10
Repairing the Accounting Workstation Option ... 12
Special Notes for International Users ............. 13

Chapter 3. Creating and Opening
Databases ........................................... 15
Master and Local Databases ....................... 15
Creating a Database ............................... 15
Opening a Local Database ......................... 18
Folders Created with the Local Database ......... 18

Chapter 4. Navigating and Editing Data ......... 19
Tools for Navigating, Manipulating and Editing Data ............................................ 19
  Mouse Buttons ................................... 19
  Icons ............................................ 19
  Keys ............................................ 21
Editing a Table .................................... 22

Chapter 5. Working with Ledgers and
Other Tables ....................................... 25
Static and Custom Fields ......................... 25
Revenue Ledgers .................................... 25
  Active Revenue Ledgers .......................... 25
Historical Revenue Ledgers ....................... 26
Static Fields ...................................... 26
Creating Active Revenue Ledgers ................ 27
Creating User Revenue Ledgers ................. 27
Expense Ledgers .................................... 27
  Active Expense Ledgers ....................... 28
Historical Expense Ledgers ....................... 28
Static Fields ...................................... 28
Creating Active Expense Ledgers ............... 29
Creating User Expense Ledgers ................. 29
Interim Ledgers .................................... 29
Creating an Interim Ledger ....................... 30
Creating Custom Fields ........................... 30
Service Category Table ........................... 32
Rate Tables ....................................... 32
  Creating a Rate Table .......................... 33
  Editing a Rate Table ............................ 34
  Deleting a Rate Table ........................... 35
Allocation Tables ................................... 36
  Static Fields .................................... 36
  Creating an Allocation Table .................. 36
  Editing an Allocation Table .................... 38
  Deleting an Allocation Table ................... 39
  Verifying an Allocation Table ................... 40
Lookup Tables ...................................... 41
  Creating a Lookup Table ....................... 41
  Editing a Lookup Table ......................... 43
  Deleting a Lookup Table ....................... 44
Direct Charge Tables .............................. 45
  Static Fields .................................... 45
  Creating a Direct Charge Table ............... 46
  Editing a Direct Charge Table ................. 47
  Deleting a Direct Charge Table ............... 48
Factor Tables ....................................... 49
  Creating a Factor Table ....................... 49
  Editing a Factor Table .......................... 50
  Deleting a Factor Table ....................... 51
Budget Tables ....................................... 52
  Static Fields .................................... 52
  Creating a Budget Table ....................... 53
  Editing a Budget Table ......................... 54
  Deleting a Budget Table ....................... 55
PERIOD Value Derivation ......................... 55

Chapter 6. Importing and Exporting
Data .................................................. 57
Data Import ....................................... 57
  Import Parameters .............................. 57
  Import File Verification ....................... 57
Importing Data .................................... 58
  Creating an Import Definition .................. 58
  Verifying Import Files ........................... 62
Importing Data from Tivoli Decision Support for OS/390 ...................................... 62
  Special Processing for Import Definition (DRLSBLDA) ......................... 63
Exporting tables .................................... 65
Preface

This book describes how to use the IBM® Tivoli® Decision Support for OS/390® (hereafter referred to as Tivoli Decision Support for OS/390) Accounting Workstation Option to manage, process, and analyze financial data on a workstation running Microsoft® Windows®.

IBM Tivoli Decision Support for OS/390 was previously known as IBM Tivoli Performance Reporter.

The term z/OS™ is used in this book to mean z/OS and OS/390 operating systems. Where the term OS/390 does appear, the related information applies only to OS/390 operating systems.

The terms MVS and OS/390 are used interchangeably throughout this book.

The terms OPC and Tivoli Workload Scheduler are used interchangeably throughout this book.

Who Should Read This Book

The Accounting Feature for the Workstation is for those users who want to use the financial analysis and charge back functions of the Accounting Workstation Option.

The financial analysis functions include the following:
  • Trending
  • Data drill-down
  • Forecasting
  • Developing custom reports
  • Query building

The IT charge-back functions include the following:
  • Applying rates
  • Prorating
  • Budgeting
  • Electronic data distribution
  • Invoice reporting
What This Book Contains

This book contains the following chapters:

- **Chapter 1, “Introduction”**
  Contains an introduction to the Accounting Workstation Option.

- **Chapter 2, “Installing, Modifying, Repairing and Removing the Product”**
  Lists the installation prerequisites and describes how to install, remove, modify and repair the Accounting Workstation Option.

- **Chapter 3, “Creating and Opening Databases”**
  Describes how to create and open databases.

- **Chapter 4, “Navigating and Editing Data”**
  Introduces the Data Explorer and describes how to navigate data and edit tables.

- **Chapter 5, “Working with Ledgers and Other Tables”**
  Introduces the ledgers and data tables you can manage with the Accounting Workstation Option and how to create and edit them.

- **Chapter 6, “Importing and Exporting Data”**
  Describes how to transfer external data into Accounting Workstation Option tables and how to transfer data from the Accounting Workstation Option to other applications.

- **Chapter 7, “Working with Data”**
  Describes the tools provided for working with data and how to use them.

- **Chapter 8, “Analysis and Reporting”**
  Describes the analysis and reporting tools and how to use them to analyze and report charge back data in the master and local database.

- **Chapter 9, “Managing Data”**
  Describes how to manage data in the database.

- **Chapter 10, “Automating Repetitive Tasks”**
  Describes how to create and run scripts to automate repetitive tasks.

- **Chapter 11, “Publishing Data Reports to an Intranet Site”**
  Describes the process of publishing data, reports, and documents to an intranet web site.

- **Chapter 12, “Navigating the Accounting Workstation Option Web Site”**
  Describes how to navigate the Accounting Workstation Option Web Site.

Publications

This section lists publications in the Tivoli Decision Support for OS/390 library and any other related documents. It also describes how to access Tivoli publications online and how to order Tivoli publications.

**Tivoli Decision Support for OS/390 Library**

The following documents are available in the Tivoli Decision Support for OS/390 library:

- *Adminstration Guide*, SH19-6816
  Provides information about initializing the Tivoli Decision Support for OS/390 database and customizing and administering Tivoli Decision Support for OS/390.

- *Guide to the Reporting Dialog*, SH19-6842
Provides information for users who display existing reports, for users who create and modify reports, and for administrators who control reporting dialog default functions and capabilities.

- **Language Guide and Reference, SH19-6817**
  Provides information for administrators, performance analysts, and programmers who are responsible for maintaining system log data and reports.

- **User’s Guide for the Viewer, SH19-4517**
  Provides information about how use the graphical interface for Tivoli Decision Support for OS/390.

- **Messages and Problem Determination, SH19-6902**
  Provides information to help operators and system programmers understand, interpret, and respond to Tivoli Decision Support for OS/390 messages and codes.

- **Accounting Feature for the Host, SH19-4495**
  Provides information for users who want to use Tivoli Decision Support for OS/390 to collect and report performance data generated by the Accounting feature.

- **Accounting Feature for the Workstation, SH19-4516**
  Provides information for users who want to use the Accounting Workstation Option to manage, process, and analyze financial data on a workstation.

- **AS/400® System Performance Feature Guide and Reference, SH19-4019**
  Provides information for administrators and users about collecting and reporting performance data generated by AS/400 systems.

- **CICS® Performance Feature Guide and Reference, SH19-6820**
  Provides information for administrators and users about collecting and reporting performance data generated by Customer Information and Control System (CICS).

- **Distributed Systems Performance Feature Guide and Reference, SH19-4018**
  Provides information for administrators and users about collecting and reporting performance data generated by operating systems and applications running on a workstation.

- **IMS™ Performance Feature Guide and Reference, SH19-6825**
  Provides information for administrators and users about collecting and reporting performance data generated by Information Management System (IMS).

- **Network Performance Feature Installation and Administration, SH19-6901**
  Provides information for network analysts or programmers who are responsible for setting up the network reporting environment.

- **Network Performance Feature Reference, SH19-6822**
  Provides information for network analysts or programmers who are responsible for setting up the network reporting environment.

- **Network Performance Feature Reports, SH19-6821**
  Provides information for network analysts or programmers who use the Network Performance feature reports.

- **System Performance Feature Guide, SH19-6818**
  Provides information for performance analysts and system programmers who are responsible for meeting the service-level objectives established in your organization.

- **System Performance Feature Reference Vol. I, SH19-6819**
Provides information for administrators and users with a variety of backgrounds who want to use Tivoli Decision Support for OS/390 to analyze Multiple Virtual Storage (MVS™), Virtual Machine (VM), or OS/2® performance data.

- **System Performance Feature Reference Vol.II**, SH19-4494
  Provides information for administrators and users with a variety of backgrounds who want to use Tivoli Decision Support for OS/390 to analyze Multiple Virtual Storage (MVS), Virtual Machine (VM), or OS/2 performance data.

- **IBM Online Library Omnibus Edition OS/390 Collection Kit**, SK2T-6700
  CD containing all OS/390 documentation.

- **IBM Online Library z/OS Software Products Collection Kit**, SK3T-4270
  CD containing all z/OS documentation.

The **Tivoli Software Glossary** includes definitions for many of the technical terms related to Tivoli Software. The **Tivoli Software Glossary** is available, in English only, at the following Web site:


**Using LookAt to Look Up Message Explanations**

LookAt is an online facility that lets you look up explanations for most messages you encounter, as well as for some system abends and codes. Using LookAt to find information is faster than a conventional search because in most cases LookAt goes directly to the message explanation.

You can access LookAt from the Internet at:


or from anywhere in z/OS or z/OS.e where you can access a TSO/E command line (for example, TSO/E prompt, ISPF, z/OS UNIX® System Services running OMVS).

The LookAt Web site also features a mobile edition of LookAt for devices such as Pocket PCs, Palm OS, or Linux-based handhelds. So, if you have a handheld device with wireless access and an Internet browser, you can now access LookAt message information from almost anywhere.

**Accessing Publications Online**

IBM posts publications for this and all other Tivoli products, as they become available and whenever they are updated, to the Tivoli Software Information Center Web site. The Tivoli Software Information Center is located at the following Web address:


Click the Tivoli Decision Support for OS/390 link to access the product library.

These publications are available in PDF or HTML format, or both. Translated documents are also available for some products.

**Note:** If you print PDF documents on other than letter-sized paper, select the **Fit to page** check box in the **Adobe Acrobat Print** dialog. This option is available when you click **File → Print.** **Fit to page** ensures that the full dimensions of a letter-sized page print on the paper that you are using.
Ordering Publications

You can order many Tivoli publications online at the following Web site:

You can also order by telephone by calling one of these numbers:
- In the United States: 800-879-2755
- In Canada: 800-426-4968

In other countries, see the following Web site for a list of telephone numbers:
http://www.ibm.com/software/tivoli/order-lit/

Accessibility

Accessibility features help users with a physical disability, such as restricted mobility or limited vision, to use software products successfully. With this product, you can use assistive technologies to hear and navigate the interface. You can also use the keyboard instead of the mouse to operate all features of the graphical user interface.

For additional information, see the Accessibility Appendix in the Administration Guide.

Contacting Software Support

If you have a problem with any Tivoli product, refer to the following IBM Software Support Web site:


If you want to contact software support, see the IBM Software Support Guide at the following Web site:

http://techsupport.services.ibm.com/guides/handbook.html

The guide provides information about how to contact IBM Software Support, depending on the severity of your problem, and the following information:
- Registration and eligibility
- Telephone numbers and e-mail addresses, depending on the country in which you are located
- Information you must have before contacting IBM Software Support

Note: For Tivoli NetView® for OS/390 customers only, additional support is available on the NETVIEW CFORUM (Customer Forum) through the IBMLink™ system. This forum is monitored by NetView developers who answer questions and provide guidance. When a problem with the code is found, you are asked to open an official problem management record (PMR) to obtain resolution.

Conventions Used in This Book

This guide uses several conventions for special terms and actions, operating system-dependent commands and paths, and margin graphics.
Typeface Conventions

This guide uses the following typeface conventions:

**Bold**
- Lowercase commands and mixed case commands that are otherwise difficult to distinguish from surrounding text
- Interface controls (check boxes, push buttons, radio buttons, spin buttons, fields, folders, icons, list boxes, items inside list boxes, multicolumn lists, containers, menu choices, menu names, tabs, property sheets), labels (such as Tip:, and Operating system considerations)
- Column headings in a table
- Keywords and parameters in text

*Italic*
- Citations (titles of books, diskettes, and CDs)
- Words defined in text
- Emphasis of words (words as words)
- Letters as letters
- New terms in text (except in a definition list)
- Variables and values you must provide

**Monospace**
- Examples and code examples
- File names, programming keywords, and other elements that are difficult to distinguish from surrounding text
- Message text and prompts addressed to the user
- Text that the user must type
- Values for arguments or command options
Chapter 1. Introduction

The Accounting Workstation Option is a Microsoft Windows-based application that can process data from various chargeback, project management, time tracking and budget applications. It has query and drill-down tools for analytical functions such as allocation, trending, forecasting, profit and loss, budget versus actual, unit costing, revenue recovery and more. You can use these tools to create a consolidated view of all IT expense data, and compare budgeted costs with actual and recovered costs.

The Accounting Workstation Option can exchange data with most conventional PC spreadsheet and database programs, such as Microsoft Excel, Lotus®, Microsoft Access, Paradox and many more. You can also import data in sequential and CSV formats. The Accounting Workstation Option can exchange data with ODBC databases like Microsoft SQL Server, Oracle and the IBM DB2 Universal Database™. The product can process data from almost any external application, regardless of platform. This means you can import and export data into your favorite desktop applications and deliver information to business units in the formats of your choice.

The desktop component of the Accounting Workstation Option contains all the executable modules, dynamic link libraries and other optional components.

The Accounting Workstation Option stores data in two physical databases:

• A master database on a networked file server
• A local database on your PC

The master database stores all application data and tables. It contains most of the standard data tables that are used by the Accounting Workstation Option. The master database can be one of the following database formats:

• Microsoft Jet
• Microsoft SQL Server

The local database stores all user data and some temporary application data. It contains any tables you create and the results of queries and functions. It is always a Microsoft Jet database.
Chapter 2. Installing, Modifying, Repairing and Removing the Product

The Accounting Workstation Option is distributed on CD as the AWO20.EXE program. Run this program to install the Accounting Workstation Option on one or more workstations. Before you install the Accounting Workstation Option, ensure that the workstation and file server meet the program requirements.

For a detailed list, see “Program Requirements.”

Note: You can use the setup program to install, remove, modify or repair components of the Accounting Workstation Option.

Program Requirements

The following sections list the program requirements for the workstation and file server.

Workstation

- Microsoft Windows 95, Windows 98, or Windows NT® Workstation 4.0 (SP3 or higher)
- IBM compatible Pentium® II processor
- 100 MHz I/O bus recommended
- 64 MB RAM
- 100 MB disk storage

File Server

- Any network operating system (NOS) that supports a DOS or an NTFS file system; for example, Novell NetWare or Windows NT.
- Data storage (1-25 GB)

Intranet Requirements

- Microsoft NT Server 4.0 or Microsoft® Windows 2000® Server
- Microsoft Internet Information Server (IIS), 5.0 (or greater)

SQL Server Requirements

When using the Accounting Workstation Option with SQL Server as your product Master database format, the following SQL Server configuration settings are required:

- The Sort Order must be set to "Dictionary order"
- The "case insensitive" option should be set to "True" (option button should be checked) in the "Character Set/Sort Order/Unicode Collation" option settings.
Installing the Accounting Workstation Option

To install the Accounting Workstation Option:

1. Close any applications. The Accounting Workstation Option setup program cannot install system files or update shared files if they are in use.

2. Insert the Accounting Workstation Option CD in the CD-ROM drive and run the SETUP.EXE program.

The Choose Setup Language window opens:

When the language has been selected, the Setup program prepares the InstallShield wizard:

When the InstallShield is fully activated, the Welcome to the InstallShield Wizard window opens:

3. Click Next.

The Choose Destination Location window opens:
4. Click Next.

The Select Setup Type window opens:

5. Select the required setup type and click Next.

The Review Settings window opens:
6. Review the settings and click Next.

Tip: To change the settings, click Back.

The Setup Status window opens:
7. When the installation has completed successfully, the InstallShield Wizard Complete window opens:

![InstallShield Wizard Complete Window]

8. Click Finish.
Uninstalling the Accounting Workstation Option

To uninstall the Accounting Workstation Option from your workstation:
2. From the Windows Settings menu select Control Panel.
   The Control Panel opens.
3. Double-click the Add/Remove Programs icon.
   The Add/Remove Programs Properties window opens.
4. From the Add/Remove Programs Properties window select AWO 2.0 and click Add/Remove.
   The InstallShield Wizard Maintenance window opens:

5. To remove the Accounting Workstation Option from your PC, select Remove and click Next.
   The Confirm File Deletion dialog window opens:

6. To confirm that you want to remove the Accounting Workstation Option, click OK.
   The ReadOnly File Detected window opens:
7. To delete this and any other read-only files that are no longer required:
   a. Select **Don't display this message again.**
   b. Click **Yes.**

   **Tip:** Other windows might prompt you to delete or keep files that may be shared by other programs.
   
   Click **No.**

When the setup program has removed all Accounting Workstation Option files from your PC, the Maintenance Complete window opens:

8. Click **Finish.**

9. In the Add/Remove Programs Properties window click **OK.**
Modifying the Accounting Workstation Option Installation

To add or remove Accounting Workstation Option components from your workstation.

2. From the Windows Settings menu select Control Panel.
   The Control Panel opens.
3. Double-click the Add/Remove Programs icon.
   The Add/Remove Programs Properties window opens.
   Tip: To add components, insert the Accounting Workstation Option CD in the CD-ROM drive.
4. From the Add/Remove Programs Properties window select AWO 2.0 and click Add/Remove.
   The InstallShield Wizard Maintenance window opens:

5. Select Modify and click Next.
   The Select Components window opens:

6. Deselect the components to be removed or select the components to be added and click Next.
When the components have been removed or added, the Maintenance Complete window opens:

7. Click Finish.
8. In the Add/Remove Programs Properties window click OK.
Repairing the Accounting Workstation Option Installation

To reinstall the Accounting Workstation Option components that are already installed on your workstation:

2. Insert the Accounting Workstation Option CD in the CD-ROM drive and run the SETUP.EXE program.

The Extracting Files window opens:

The InstallShield Wizard Maintenance window opens:

3. Select Repair and click Next. All previously installed components are reinstalled.
When the components have been reinstalled, the Maintenance Complete window opens:

4. Click Finish.

**Special Notes for International Users**

There are several places where the Accounting Workstation Option may display error messages in English. In most cases, these messages come from the underlying Microsoft Windows operating system. You may also see English messages during the installation of the product. Both of these occurrences are normal.

Throughout the Accounting Workstation Option, the names of tables, fields within tables, the web site and actual folder names do not support NLV characters. Please restrict these names to letters and numbers.

When using the Data Explorer feature with the Japanese version of the Accounting Workstation Option, the text on the right side of the window may not correctly display the Japanese double byte characters if the window is resized. Keep this in mind when resizing the window so that the information is correctly displayed.

When software products such as the Accounting Workstation Option are translated into several languages, there may be duplicate hotkeys on some forms. If duplicate hotkeys appear on a form, use the mouse rather than the hotkey character to make your selection.
Chapter 3. Creating and Opening Databases

Master and Local Databases

Every local database must be connected to a master database. One master database can be connected to several local databases. The connection information to the master database is stored in the local database. When you open the local database, the associated master database opens automatically.

The first database you create must be an empty master database. Thereafter you can create local databases and associate them with the original master database.

Creating a Database

To create a database, perform the following steps:

1. From the Windows Start button, select:
   a. The Windows Programs menu
   b. Tivoli
   c. Accounting Workstation Option 2.0

   The PR for OS/390: Accounting Workstation Option window opens. When you run the product for the first time, it automatically opens the Demo database. On subsequent occasions, it opens the last database you opened.

2. From the File menu, select New.
   The New Database window opens:
3. Navigate to the directory where you want to create a new folder and click **New Folder**.
The New Folder pop-up opens:

![New Folder pop-up](image)

4. Type the name of the folder and click **OK**.
The New Database window opens:

![New Database window](image)

5. Click **OK**.
The Local Database Created dialog opens:

![Local Database Created dialog](image)

6. Click **OK**.
The New Master Connection window opens:

![New Master Connection window](image)
7. To connect the new local database with the master database, perform the following steps:
   a. Select the required database type.
   b. Select **Create new database**.
   c. Click **OK**.

If the master database is a Microsoft Access database, the Save Microsoft Access Database window opens:

![Save Microsoft Access Database Window](image)

**Tip:** To connect an existing master database to a new local database, perform the following steps instead of Step 7 and skip Step 8:
   a. Select the required database type.
   b. Select **Open existing database**.
   c. Navigate to and select the master database to connect with this local database and click **Open**. The new local database opens.

If you select a database that is not a master database, a dialog window opens with an error message. Repeat Step 7c.

8. Type the name of the new database and click **Save**.
   The new database opens.
Opening a Local Database

To open a local database, perform the following steps:

1. From the File menu, select **Open**.

   The Open Local Database window opens:

2. Select the required database and click **Open**. If the required database is not on the list of databases, perform the following steps:
   a. Select **More** and click **OK**.
   b. Select the database and click **Open**.

   The database opens.

**Tip:** To determine which master database is associated with the open local database, select **System Status** from the File menu.

Folders Created with the Local Database

The local database is created and stored in a single folder. The following folders are created in the folder that contains the database:

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data\Environ</td>
<td>Not used</td>
</tr>
<tr>
<td>Data\Explode</td>
<td>Default target for output of the Data Delivery function</td>
</tr>
<tr>
<td>Data\Export</td>
<td>Default target for output of Export functions</td>
</tr>
<tr>
<td>Data\Host</td>
<td>Default source directory for host input data</td>
</tr>
<tr>
<td>Data\Import</td>
<td>Default source directory for imported files</td>
</tr>
<tr>
<td>System\Batch Scripts</td>
<td>Contains custom batch scripts</td>
</tr>
<tr>
<td>System\Import Definitions</td>
<td>Contains custom import definitions</td>
</tr>
<tr>
<td>System\Export Definitions</td>
<td>Contains custom export definitions</td>
</tr>
<tr>
<td>System\Sql</td>
<td>Contains SQL programs</td>
</tr>
<tr>
<td>System\Reports</td>
<td>Contains custom report definitions</td>
</tr>
<tr>
<td>System\Query Definitions</td>
<td>Contains query definitions</td>
</tr>
<tr>
<td>System\Charts</td>
<td>Contains chart definitions</td>
</tr>
<tr>
<td>Intranet</td>
<td>Accounting Workstation Option web site image</td>
</tr>
<tr>
<td>System\FTP</td>
<td>Contains FTP definitions</td>
</tr>
</tbody>
</table>
Chapter 4. Navigating and Editing Data

The Data Explorer is the single point of access to all data, tables and functions in the Accounting Workstation Option. You can access the Data Explorer as follows:

- From the File menu select **Data Explorer**.
- In the Accounting Workstation Option toolbar, click the Data Explorer icon.
- In the empty Main window, double click the gray area. The Data Explorer window opens:

### Tools for Navigating, Manipulating and Editing Data

The following sections describe how to navigate, manipulate and edit data in the Data Explorer window with mouse buttons, icons and keys.

#### Mouse Buttons

- To expand a branch, click the plus (+) sign in front of the node.
- To collapse a branch, click the minus (-) sign in front of the node.
- To display the functions available for the highlighted node, click the right mouse button.
- To display the contents of a table in the Explorer window, click the table name.

#### Icons

The following icons are available in the Data Explorer toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📋</td>
<td>New Record</td>
<td>Adds new record to the table</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Delete Record</td>
<td>Deletes selected record(s)</td>
<td></td>
</tr>
<tr>
<td>Print Contents of Grid</td>
<td>Prints entire contents of table</td>
<td></td>
</tr>
<tr>
<td>Save as local table</td>
<td>Saves table to local database</td>
<td></td>
</tr>
<tr>
<td>Cut Record</td>
<td>Cuts marked data to clipboard</td>
<td></td>
</tr>
<tr>
<td>Copy Record</td>
<td>Copies marked data to clipboard</td>
<td></td>
</tr>
<tr>
<td>Paste Record</td>
<td>Pastes data from clipboard into marked area</td>
<td></td>
</tr>
<tr>
<td>Freeze Column</td>
<td>Prevents marked columns from scrolling</td>
<td></td>
</tr>
<tr>
<td>Sort Ascending</td>
<td>Sorts data using active column</td>
<td></td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Sorts data using active column</td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Opens search window</td>
<td></td>
</tr>
<tr>
<td>Filter by Selection</td>
<td>Applies filter based on selection from pull-down list</td>
<td></td>
</tr>
<tr>
<td>Filter (Replace)</td>
<td>Applies filter based on selected value</td>
<td></td>
</tr>
<tr>
<td>Filter (Append)</td>
<td>Appends existing filter using selected value</td>
<td></td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Remove all filter criteria</td>
<td></td>
</tr>
<tr>
<td>Open in Microsoft Access</td>
<td>Opens copy of data in Microsoft Access</td>
<td></td>
</tr>
<tr>
<td>Open in Microsoft Excel</td>
<td>Opens copy of data in Microsoft Excel</td>
<td></td>
</tr>
<tr>
<td>Export</td>
<td>Exports data to selected format</td>
<td></td>
</tr>
</tbody>
</table>
# Keys

The following keys and key combinations are available for navigating the grid.

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up Arrow</td>
<td>Moves active cell up one row</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Moves active cell down one row</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Moves active cell right one column</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Moves active cell left one column</td>
</tr>
<tr>
<td>Shift+arrow</td>
<td>Extends selection in direction of arrow key</td>
</tr>
<tr>
<td>Page Up</td>
<td>Moves active cell one page up</td>
</tr>
<tr>
<td>Page Down</td>
<td>Moves active cell one page down</td>
</tr>
<tr>
<td>Ctrl+Page Up</td>
<td>Moves active cell one page left</td>
</tr>
<tr>
<td>Ctrl+Page Down</td>
<td>Moves active cell one page right</td>
</tr>
<tr>
<td>Home</td>
<td>Moves active cell to first cell in row</td>
</tr>
<tr>
<td>End</td>
<td>Moves active cell to last cell in row that contains data</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Moves active cell to first row, first column</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>Moves active cell to last row and column that contain data</td>
</tr>
<tr>
<td>Tab</td>
<td>Moves active cell to the right (or down at end of row)</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Moves active cell to the left (or up at beginning of row)</td>
</tr>
<tr>
<td>Shift+Space</td>
<td>Selects current row</td>
</tr>
<tr>
<td>Ctrl+Space</td>
<td>Selects current column</td>
</tr>
<tr>
<td>Shift+Ctrl+Space</td>
<td>Selects entire grid</td>
</tr>
<tr>
<td>Shift+Delete or Ctrl+X</td>
<td>Cuts current selection or active cell’s data to Clipboard</td>
</tr>
<tr>
<td>Shift+Ins or Ctrl+V</td>
<td>Pastes Clipboard contents into active cell</td>
</tr>
<tr>
<td>Ctrl+Ins or Ctrl+C</td>
<td>Copies current selection or active cell’s data to Clipboard</td>
</tr>
<tr>
<td>Esc</td>
<td>If in edit mode, previous cell value replaces new value and edit mode is turned off</td>
</tr>
<tr>
<td>F2</td>
<td>If edit mode is on, cell value is cleared</td>
</tr>
<tr>
<td>F3</td>
<td>If edit mode is on in a date or time cell, current date or time is placed in cell</td>
</tr>
<tr>
<td>F4</td>
<td>If edit mode is on in a date cell, grid displays a pop-up calendar to let you choose a date</td>
</tr>
</tbody>
</table>
Editing a Table

You update Accounting Workstation Option tables in the grid display of the Data Explorer. Most grid displays have the same functionality and toolbar. Incremental saves of the data table are not necessary because each change or addition to a data table is saved when editing of each record is complete.

To edit a table, perform the following steps:

1. Open the database.
2. From the File menu, select **Data Explorer**.
   The Data Explorer window opens:

   ![Data Explorer](image)

   **Data Explorer Functions:**
   - Each branch of the data explorer can be expanded by clicking on the plus sign (+) and collapsed by clicking on the minus sign (-) in front of each node.
   - Hit F5 to refresh data explorer's tree.
   - When positioned on a node, click the right mouse button to display the available functions.
   - When positioned on a table node, this window will display the table using a grid display.
   - Nearly all grid displays provide the same functionality and toolbar. Toolbar button function names are displayed when you move the cursor over the button images.
   - Use the following keys to navigate the data grid display:
     - Up Arrow: Moves active cell up one row
     - Down Arrow: Moves active cell down one row
     - Right Arrow: Moves active cell right one column
     - Left Arrow: Moves active cell left one column
     - Page Up: Moves active cell one page up
     - Page Down: Moves active cell one page down
     - Home: Moves active cell to first cell in row
     - End: Moves active cell to last cell in row that contains data
     - Tab: Moves active cell to the right
     - Esc: If in edit mode, previous cell value replaces new value

3. Browse the tree view in the left panel and select a table to edit.
The right panel of the Data Explorer window displays the data in the selected table:

4. Use the icons, keys and mouse buttons to navigate, manipulate and edit the data.

**Data Explorer Functions:**

- Each branch of the data explorer can be expanded by clicking on the plus sign (+) and collapsed by clicking on the minus sign (-) in front of each node.
- Hit F5 to refresh data explorer's tree.

When positioned on a node, click the right mouse button to display the available functions.

When positioned on a table node, this window will display the table using a grid display. Nearly all grid displays provide the same functionality and toolbar. Toolbar button function names are displayed when you move the cursor over the button images.

Use the following keys to navigate the data grid display:

- Up Arrow: Moves active cell up one row
- Down Arrow: Moves active cell down one row
- Right Arrow: Moves active cell right one column
- Left Arrow: Moves active cell left one column
- Page Up: Moves active cell one page up
- Page Down: Moves active cell one page down
- Home: Moves active cell to first cell in row
- End: Moves active cell to last cell in row that contains data
- Tab: Moves active cell to the right
- Esc: If in edit mode, previous cell value replaces new value
IBM Tivoli® Decision Support for OS/390®: Accounting Feature for the Workstation
Chapter 5. Working with Ledgers and Other Tables

This chapter describes the types, structure and content of ledgers and tables, and how to create, modify and delete them.

Static and Custom Fields

Ledgers are tables that contain data in static fields, custom fields, or both. Each ledger or table has its own set of predefined static fields. For revenue ledgers, expense ledgers and budget tables you can create custom fields to store additional data. For example, organizational data (like department, division and cost center), your general ledger numbers, or flags for certain data conditions.

You can name these fields yourself and store the following types of data:
- Text (1-200 bytes)
- Decimal
- Integer
- Currency (Windows default format)
- Date / Time

Revenue Ledgers

Revenue ledgers contain utilization and revenue data collected from external data sources, IT charge back applications or interfaces to other external applications. This data often represents detailed or summarized usage of IT products and services. Revenue ledgers are either active or historical.

Revenue ledgers contain both static and custom fields.

You create revenue ledgers with the Create Active Ledgers function. You must define any custom fields before you create any ledgers so that the desired fields are present in the tables.

For information about creating custom fields, see "Creating Custom Fields" on page 30.

For information about the static fields that are automatically created for revenue ledgers, see "Static Fields" on page 26.

Active Revenue Ledgers

There are four active revenue ledgers for the current period but you can create others if necessary.

The active revenue ledgers are:
- ledger_active
  This is the active revenue ledger that contains revenue data for the current period. It is often called the active ledger.
- ledger_pdt
  This ledger is used to store period-to-date revenue information.
- ledger_test
  This ledger is created to assist you with testing.
ledger_suspend
This ledger is used to hold invalid or incomplete data. The data may be corrected and processed in future periods or deleted.

Historical Revenue Ledgers
Historical revenue ledgers are named LGpppppp

where:

pppppp represents the period value of the data within the table. You create historical revenue ledgers with the Finalize Ledger function.

Static Fields
The following table shows the static fields for revenue ledgers.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period</td>
<td>Period</td>
</tr>
<tr>
<td>TYPE</td>
<td>Record type</td>
</tr>
<tr>
<td>SEQUENCE</td>
<td>Sequence number</td>
</tr>
<tr>
<td>ENTRTIME</td>
<td>Entry Date/Time</td>
</tr>
<tr>
<td>DATASRC</td>
<td>Data source</td>
</tr>
<tr>
<td>SERVCAT</td>
<td>Service Category</td>
</tr>
<tr>
<td>SERVICE</td>
<td>Service</td>
</tr>
<tr>
<td>QUANTITY</td>
<td>Quantity</td>
</tr>
<tr>
<td>RATE</td>
<td>Rate</td>
</tr>
<tr>
<td>CHARGES</td>
<td>Charges</td>
</tr>
</tbody>
</table>
Creating Active Revenue Ledgers

You must define the custom fields for the active revenue ledgers before creating the ledgers.

For information about creating custom fields, see “Creating Custom Fields” on page 30.

To create active revenue ledgers, perform the following steps:
1. From the Functions menu, select Data Management, then Create Active Ledgers.
   The Create Ledger window opens:

2. To create all active ledgers, select Revenue and click Execute.
3. A confirmation dialog opens for each of the four active ledgers to be created. Click OK when prompted until all ledgers have been created.

Tip: You can also create revenue ledgers with the Create User Ledgers function.

Creating User Revenue Ledgers

To create a user revenue ledger, perform the following steps:
1. From the Functions menu, select Data Management, then Create User Ledger.
   The Create Ledger window opens.
2. Specify a user ledger name in the Ledger Name box.
3. To create the user revenue ledger, select Revenue and click Execute.
   A confirmation dialog opens for the ledger to be created.
4. Click OK.

Expense Ledgers

Expense ledgers contain expense data collected from external applications. IT expense data is often imported from the corporate general ledger system.

Expense ledgers are either active or historical.

You create expense ledgers with the Create Active Ledgers function.

Expense ledgers contain both static and custom fields.

For information about creating custom fields, see “Creating Custom Fields” on page 30.

For information about the static fields that are automatically created for expense ledgers, see “Static Fields” on page 28.
**Active Expense Ledgers**

There are four active expense ledgers for the current period but you can create others if required.

The active expense ledgers are:

- **expense_active**
  - This is the active expense ledger and contains expense data for the current period. This is often called the active expense ledger.

- **expense_ptd**
  - This ledger is used to store period-to-date expense information.

- **expense_test**
  - This ledger is created to assist you with testing.

- **expense_suspend**
  - This ledger is used to hold invalid or incomplete data. The data can be corrected and processing in future periods or deleted.

**Historical Expense Ledgers**

Historical expense ledgers are named EXpppppp

where:

- pppppp represents the period value of the data within the table.

You create historical expense ledgers with the **Finalize Ledger** function.

**Static Fields**

The following table shows the static fields for expense ledgers.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERIOD</td>
<td>Period</td>
</tr>
<tr>
<td>TYPE</td>
<td>Record Type</td>
</tr>
<tr>
<td>SEQUENCE</td>
<td>Sequence Number</td>
</tr>
<tr>
<td>ENTRTIME</td>
<td>Entry Date/Time</td>
</tr>
<tr>
<td>DATASRC</td>
<td>Data Source</td>
</tr>
<tr>
<td>SERVCAT</td>
<td>Service Category</td>
</tr>
<tr>
<td>SERVICE</td>
<td>Service</td>
</tr>
<tr>
<td>EXPENSES</td>
<td>Charges</td>
</tr>
</tbody>
</table>
Creating Active Expense Ledgers

You must define any custom fields before you create any ledgers so that the required fields are present in the tables. For information about creating custom fields, see “Creating Custom Fields” on page 30.

To create active expense ledgers, perform the following steps:

1. From the Functions menu, select Data Management, then Create Active Ledgers.

   The Create Ledger window opens:

   ![Create Ledger Window](image)

   2. To create all active expense ledgers, select Expense and click Execute.

      A confirmation dialog opens for each of the four active ledgers to be created.

   3. Click OK when prompted until all ledgers have been created.

   Tip: You can also create user expense ledgers with the Create User Ledgers function.

Creating User Expense Ledgers

To create a user expense ledger, perform the following steps:

1. From the Functions menu, select Data Management, then Create User Ledger.

   The Create Ledger window opens:

   ![Create Ledger Window](image)

   2. Specify a user ledger name in the Ledger Name box.

   3. Select Expense and click Execute.

      A confirmation dialog opens for the ledger to be created.

   4. Click OK.

Interim Ledgers

Use interim ledgers as a backup so that you can reverse the changes a function makes to the active expense or revenue ledger. Interim ledgers are created from either ledger_active or expense_active and always contain the same fields as the ledger from which they are created.

When you execute functions interactively and you have selected an active ledger, you are always prompted if you want to create an interim ledger first. However, you may want to create an interim ledger without executing a function; for example, when you are executing user written SQL procedures or editing a ledger.
Creating an Interim Ledger

To create an interim ledger, perform the following steps:

1. From the Functions menu, select Data Management, then Create Interim Ledger.

The Ledger Type window opens:

2. Select the required ledger type and click OK.

A confirmation dialog opens for the ledger to be created.

3. Click OK.

Creating Custom Fields

To create custom fields, perform the following steps:

1. From the Maintain menu, select Custom Fields.

The Custom Fields window opens:

2. To create a new field, click Add.

The Create Custom Fields window opens:

3. Enter the field name in the input box and click OK.
Tip: The field name can be up to 8 alphanumeric characters long and *must* begin with a letter.

The Edit Field window opens:

![Edit Field Window](image)

4. Select a field type from the Field Type list box.

   **Tip:** If you select **Text**, you must also specify the number of characters in the **Size** box.

5. Specify one or more table categories. You *must* choose at least one of these categories. If you select **Text**, you must also specify the number of characters in the **Size** box.

   **Tip:** Select the revenue category to add the user field to all revenue ledgers, the expense category to add the user field to all expense ledgers, or the budget category to add the user field to all budget tables.

6. Select **Indexed Field** if you want to create an index for this field.

7. Specify a field description in the **Field Description** box.

8. When all specifications are complete, click **OK**.
Service Category Table

Service category is the name you give to a group of services. The service category table contains a single entry for each category of service. The service category field (SERVCAT) can contain up to 10 letters or numbers. Each service category must have a description.

The following table shows the fields in the service category table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVCAT</td>
<td>Service Category</td>
</tr>
<tr>
<td>SC_GLGL</td>
<td>Account Assigned to this Service Category (optional)</td>
</tr>
<tr>
<td>SC_DESC</td>
<td>Service Category Description</td>
</tr>
</tbody>
</table>

Rate Tables

Rate tables contain data that maps services to rates and service categories. You can create multiple rate tables. The active rate table is called rates_active. All other rate tables are user defined and can be used in place of the active rate table in functions for setting future rates, rate simulation, or for maintaining history. Rate tables are used by the Apply Rate Table function to assign rates to services and calculate charges for a ledger.

Each rate table contains a single entry for each service. The service field, SERVICE, can contain up to 10 letters or numbers. A service rate (Currency data type) must be associated with the service. The service must also be associated with a service category, SERVCAT, and optionally with a general ledger account number.

Every unique rate must have a unique service name.

The following table shows the fields in the rate table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVCAT</td>
<td>Service category</td>
</tr>
<tr>
<td>SERVICE</td>
<td>Service</td>
</tr>
<tr>
<td>RATE</td>
<td>Rate</td>
</tr>
<tr>
<td>SV_GL</td>
<td>General ledger account assigned to this service</td>
</tr>
<tr>
<td>SV_DESC</td>
<td>Service description</td>
</tr>
<tr>
<td>SV_MAP</td>
<td>Service mapping</td>
</tr>
<tr>
<td>APPLY</td>
<td>Flag for use in Apply Rate Table function</td>
</tr>
</tbody>
</table>
Creating a Rate Table

To create a rate table, perform the following steps:

1. From the Maintain menu, select Rate Tables.
   The Select Rate Table window opens:

   ![Select Rate Table Window]

   2. Click New.
   The Create New Rate Table window opens:

   ![Create New Rate Table Window]

   3. Select the required Create Option.
      Tip: If you choose to copy from an existing rate table, you must select a source rate table from the Select Rate Table list box.

   4. To save the SQL code to be executed by this function, click Save SQL.
      The Create New Rate Table window opens.

   5. Type the rate table name and click OK.
      The Open SQL Program window opens.

   6. Type a file name and click Save.
   7. To execute the function, click Execute.
**Editing a Rate Table**

To edit a rate table, perform the following steps:

1. From the Maintain menu, select **Rate Tables**. The Select Rate Table window opens:

2. Select a table and click **Edit**. The Edit Table window opens with data from the selected table:

3. Edit the table. For information about editing tables, see "Tools for Navigating, Manipulating and Editing Data" on page 19.
Deleting a Rate Table

To delete a rate table, perform the following steps:

1. From the Maintain menu, select Rate Tables.
   The Select Rate Table window opens:

   ![Select Rate Table Window](image)

   2. Select a table and click Delete.
      A confirmation dialog opens for the table to be deleted.
   3. Click Yes.
Allocation Tables

Allocation tables are used as input to the **Apply Allocation Table** function to distribute numerical data in a table using percentages. You can define multiple allocation tables. The structure of an allocation table is defined when you create the table. There are both custom and static fields in an allocation table. Prefix custom fields with FROM_ if they are to be used to distribute from and TO_ if they are to be used to distribute to.

For information about creating custom fields, see “Creating Custom Fields” on page 30.

For information about the static fields that are automatically created for allocation tables, see “Static Fields.”

**Static Fields**

The following table shows the static fields for allocation tables:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERCENT</td>
<td>Percent</td>
</tr>
<tr>
<td>ERROR</td>
<td>Error Flag</td>
</tr>
</tbody>
</table>

**Creating an Allocation Table**

You *must* validate allocation tables before using them. This ensures that the PERCENT field for each unique set of FROM fields totals 100 percent.

To create an allocation table, perform the following steps:

1. From the Maintain menu, select **Allocation Tables**.
   
   The Select Allocation Table window opens:

   ![Select Allocation Table Window](image)

2. Click **New**.
3. Select a table from the Input Table list box.
4. Select one or more fields from the Source Fields list box.
5. Select one or more fields from the Target Fields list box. For each field selected in the Target Fields list box, specify if a value is required for that field.
6. To save the SQL code to be executed by this function, click Save SQL.
   The Create New Allocation Table window opens.
7. Type the allocation table name and click OK.
   The Open SQL Program window opens.
8. Type a file name and click Save.
Editing an Allocation Table

To edit an allocation table, perform the following steps:

1. From the Maintain menu, select Allocation Table.
   The Select Allocation Table window opens:

2. Click Edit.
   The Edit Table window opens with data from the selected table:

3. Edit the table.
   For information about editing tables, see "Tools for Navigating, Manipulating and Editing Data" on page 19.
Deleting an Allocation Table

To delete an allocation table, perform the following steps:

1. From the Maintain menu, select Allocation Tables.

The Select Allocation Table window opens:

2. Click Delete.

   A confirmation dialog opens for the table to be deleted.

3. Click Yes.
Verifying an Allocation Table

To verify an allocation table, perform the following steps:

1. From the Maintain menu, select Allocation Tables.

   The Select Allocation Table window opens:

2. Select a table to verify and click Verify.

   If the table passes the verification process, the following verification dialog opens:

   ![Verification dialog]

   If the table fails the verification process, perform the following steps:

   1. In the Select Allocation Table window, select Records in Error and click Edit.
   2. Make the required corrections and repeat the verification process.
Lookup Tables

Lookup tables are used as input to the Apply Lookup function to map the values in one input field to one or more output fields. You can define multiple lookup tables. The structure of a lookup table is defined when you create it. There can be both custom and static fields in a lookup table.

Creating a Lookup Table

To create a lookup table, perform the following steps:

1. From the Maintain menu, select Lookup Tables.
   The Select Lookup Table window opens:

   ![Select Lookup Table](image)

   2. Click New.
   The Create New Lookup Table window opens:

   ![Create New Lookup Table](image)

   3. Select a table from the Input Table list box to be used as the target during the lookup process.

   **Tip:** The structure of a lookup table is based on the structure of the table that is the target of the lookup.

   4. Select a source field from the Input Field list box.

   5. Select one or more fields from the Output Fields list box. For each field selected in the Target Fields list box, specify if a value is required for that field.

Chapter 5. Working with Ledgers and Other Tables  41
6. To save the SQL code to be executed by this function, click **Save SQL**. The Create New Lookup Table window opens.

7. Type the lookup table name and click **OK**. The Open SQL Program window opens.

8. Type a file name and click **Save**.

9. To execute the function, click **Execute**.
Editing a Lookup Table

To edit a lookup table, perform the following steps:

1. From the Maintain menu, select Lookup Tables.
   The Select Lookup Table window opens:

2. Click Edit.
   The Edit Table window opens with data from the selected table:

3. Edit the table.
   For information about editing tables, see "Tools for Navigating, Manipulating, and Editing Data" on page 19.
Deleting a Lookup Table

To delete a lookup table, perform the following steps:

1. From the Maintain menu, select **Lookup Tables**.
   The Select Lookup Table window opens:

   ![Select Lookup Table Window](image)

   2. Click **Delete**.
      A confirmation dialog opens for the table to be deleted.
   3. Click **Yes**.
Direct Charge Tables

Direct charge tables are used as input to the Apply Direct Charge function. Direct charge tables contain entries for one time or recurring charges.

The structure of a direct charge table is based on static fields and selected fields from a revenue ledger.

Static Fields

The following table shows the static fields for direct charge tables:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>Service</td>
</tr>
<tr>
<td>DC_START</td>
<td>Starting Period</td>
</tr>
<tr>
<td>DC_END</td>
<td>Ending Period</td>
</tr>
<tr>
<td>QUANTITY</td>
<td>Quantity</td>
</tr>
<tr>
<td>CHARGES</td>
<td>Direct Charge</td>
</tr>
</tbody>
</table>
Creating a Direct Charge Table

To create a direct charge table, perform the following steps:

1. From the Maintain menu, select Direct Charge Tables.
   The Select Direct Charge Table window opens:

   ![Select Direct Charge Table](image1)

   2. Click New.
   The Create New Direct Charge Table window opens:

   ![Create New Direct Charge Table](image2)

   3. Select a ledger from the Input Table list box.
   Tip: The structure of a direct charge table is based on the structure of a ledger.

   4. Select one or more fields from the Fields list box. For each field selected in the Fields list box, specify if a value is required for that field.

   5. To save the SQL code to be executed by this function, click Save SQL.
   The Create New Direct Charge Table window opens.

   6. Type the direct charge table name and click OK.
   The Open SQL Program window opens.

   7. Type a file name and click Save.

   8. To execute the function, click Execute.
Editing a Direct Charge Table

To edit a direct charge table, perform the following steps:

1. From the Maintain menu, select Direct Charge Tables. The Select Direct Charge Table window opens:

   ![Select Direct Charge Table window](image)

   2. Click Edit. The Edit Table window opens with data from the selected table:

   ![Edit Table window](image)

   3. Edit the table. For information about editing tables, see “Tools for Navigating, Manipulating and Editing Data” on page 19.
Deleting a Direct Charge Table

To delete a direct charge table, perform the following steps:

1. From the Maintain menu, select Direct Charge Tables.
   The Select Direct Charge Table window opens:

   ![Select Direct Charge Table Window]

   2. Click Delete.
      A confirmation dialog opens for the table to be deleted.
   3. Click Yes.
Factor Tables

Factor tables are used as input to the **Apply Factor** function to lookup and apply a factor value to one or more numeric fields in the target table. You can define multiple factor tables. The structure of a factor table is defined when you create it. The structure is based on a single field you select from an input table.

Creating a Factor Table

To create a factor table, perform the following steps:

1. From the Maintain menu, select **Factor Tables**.
   
   The Select Factor Table window opens:

   ![Select Factor Table](image)

2. Click **New**.

   The Create New Factor Table window opens:

   ![Create New Factor Table](image)

3. Select a table from the Input Table list box to be used as the target during the apply factor process.

   **Tip:** The structure of a factor table is based on the structure of the table to be the target of the **Apply Factor Table** function.

4. Select a source field from the Input Field list box.

5. To save the SQL code to be executed by this function, click **Save SQL**.

   The Create New Factor Table window opens.

6. Type the factor table name and click **OK**.

   The Open SQL Program window opens.

7. Type a file name and click **Save**.

8. To execute the function, click **Execute**.
Editing a Factor Table

To edit a factor table, perform the following steps:

1. From the Maintain menu, select Factor Tables.
   The Select Factor Table window opens:

   ![Select Factor Table Window]

   2. Select a table and click Edit.
      The Edit Table window opens with data from the selected table.

   ![Edit Table Window]

   3. Edit the table.
      For information about editing tables, see “Tools for Navigating, Manipulating and Editing Data” on page 19.
Deleting a Factor Table

To delete a factor table, perform the following steps:

1. From the Maintain menu, select **Factor Tables**.
   
The Select Factor Table window opens:

2. Click **Delete**.
   
   A confirmation dialog opens for the table to be deleted.

3. Click **Yes**.
Budget Tables

Budget Tables are used to record user and IT budget information. The data is used in reporting and data analysis. For example, comparing budgeted revenue with collected revenue.

Budget tables contain both static and custom fields.

For information about creating custom fields, see “Creating Custom Fields” on page 30.

For information about the static fields that are automatically created for budget tables, see “Static Fields.”

Static Fields

The following table shows the static fields for budget tables:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEQUENCE</td>
<td>Sequence Number</td>
</tr>
<tr>
<td>ENTRTIME</td>
<td>Entry Date/Time</td>
</tr>
<tr>
<td>DATASRC</td>
<td>Data Source</td>
</tr>
<tr>
<td>SERVCAT</td>
<td>Service Category</td>
</tr>
<tr>
<td>SERVICE</td>
<td>Service</td>
</tr>
<tr>
<td>BUD_QNT</td>
<td>Budget Quantity</td>
</tr>
<tr>
<td>BUD_RATE</td>
<td>Budget Rate</td>
</tr>
<tr>
<td>BUD_AMT</td>
<td>Budget Amount</td>
</tr>
</tbody>
</table>
Creating a Budget Table

To create a budget table, perform the following steps:

1. From the Maintain menu, select Budget.
   The Select Budget Table window opens:

2. Click New.
   The Create New Budget Table window opens:

3. Specify a Create Option to create an empty budget table or create an budget table as copy of an existing budget table. If you choose to copy from an existing budget table, you must select a source budget table from the Select Budget Table list box.

4. To save the SQL code to be executed by this function, click Save SQL.
   The Create New Budget Table window opens.

5. Type the budget table name and click OK.
   The Open SQL Program window opens.

6. Type a file name and click Save.
7. To execute the function, click Execute.
**Editing a Budget Table**

To edit a budget table, perform the following steps:

1. From the Maintain menu, select **Budget Tables**.
   The Select Budget Table window opens:

   ![Select Budget Table](image1)

2. Click **Edit**.
   The Edit Table window opens with data from the selected table:

   ![Edit Table](image2)

3. Edit the table.
   For information about editing tables, see “Tools for Navigating, Manipulating and Editing Data” on page 19.
Deleting a Budget Table

To delete a budget table, perform the following steps:

1. From the Maintain menu, select **Budget Tables**.
   The Select Budget Table window opens:

   ![Select Budget Table Window]

   2. Click **Delete**.
      A confirmation dialog opens for the table to be deleted.

   3. Click **Yes**.

**PERIOD Value Derivation**

The Accounting Workstation Option uses the following logic to determine the active billing period:

1. The Accounting Workstation Option reviews the PERIOD column value for the first record in the "ledger_active" table. If the "ledger_active" table is not empty, and the PERIOD column is not NULL, then the Accounting Workstation Option assigns the current period to the discovered value.

2. If the "ledger_active" table is empty or missing, then the Accounting Workstation Option looks for the existence of the most recent historical ledger table. If such a historical ledger exists, then the Accounting Workstation Option assigns the current effective period to the NEXT logical period. For example, if the Accounting Workstation Option found a historical ledger table named "lg200204" to be the most recent (and the "ledger_active" table was empty or missing), then the Accounting Workstation Option would set the effective period to "200205".

3. If the Accounting Workstation Option fails to locate a current "ledger_active" and there are no historical ledgers available (this usually only occurs when a new database is created), then it reviews the entries in the "calendar" table to assign the effective period. The Accounting Workstation Option attempts to find an entry in the "calendar" table that matches the current system date. If it finds an entry, it assigns the effective period to the PERIOD value specified located row of the "calendar" table.

4. If all of the above logic to determine the current billing period fails, then the Accounting Workstation Option assigns the current period based on the system date only.

The current period value can be viewed by selecting the "System Status" option from the "File" menu.
Chapter 6. Importing and Exporting Data

This chapter describes how to transfer data into and out of Accounting Workstation Option tables.

Data Import

The process of transferring data from an external source into an Accounting Workstation Option table is called importing. You can import data into any Accounting Workstation Option table. A typical use is to import data into the revenue ledger for each input data source during the billing cycle. However, you can also fill other tables such as lookup tables, allocation tables, expense ledgers and budget tables with imported data instead of manually entering each record.

Import Parameters

Before you can import any data, you must specify the following parameters:
- The structure of the data to be imported
- The table to import the data into
- The import method

You specify this information in an import definition. Save import definitions for future use so that you can repeat the import operation without having to specify all the information every time. You must give each import definition a unique name of between one and eight alpha characters. Import definitions have the file type .IMD. They are stored in the \System\Import Definitions folder.

Import File Verification

Every time you successfully post data from an external file, an entry is created in the Accounting Workstation Option activity_log table. The log records the name of the import definition and timestamp of when the data was posted to the table. The Import File Verification function compares this information with the statistics of the existing file. It verifies that each file specified in an Import Definition exists and has been updated since the last time it was imported.
Importing Data

Before importing any data, consider:
- The table into which to import the data
- The processing options to use

Tips: You can import and view data as often as required without posting it to a table. Always view the imported data to test your import definition before posting the data.

If you specify the Replace option and there is existing data in the table, any existing data is overwritten when you post the imported data.

After importing data, verify that the import operation was successful.

Creating an Import Definition

To create an Import Definition, perform the following steps:
1. From the Functions menu, select Import.
   The Import window opens:

2. Click New.
   The New Import Definition window opens.
3. Type the name of the new import definition and click OK.
4. Select the format of the input file from the Select Import File Type list box.
5. Select an input file or table name from the Select Input File/Table list box.
   Tip: To locate and input file or table, click Browse.
6. Click Next.

IBM Tivoli® Decision Support for OS/390®: Accounting Feature for the Workstation
7. If the input file type is delimited text, the following Import window opens:

8. Perform the following steps:
   a. Select the field separator character.
   b. If the input file contains a header record that contains field names, select First Row Contains Field Names.
   c. Click Next.
If the input file type is fixed width text, the following Import window opens:

9. In the grid labeled Fixed-width text definition, specify a record layout for the input file.

10. Click Next.
11. The final Import window opens:

   ![Import window screenshot]

12. In the Specify Target table list box, select the table into which to import the data.

13. To save the existing import definition, click **Save Def**.

14. To import the source file, click **Import**.

15. When the import operation is complete, review the Import Results section of the form for statistics on the import process.

   **Tip:** To review the input data for validation before posting it, click **View Data**.

   If necessary, click **Back**, make any corrections and repeat the import process.

16. When you are satisfied that both data and formatting are correct, click **Post** to load the data into the target table.

   The New Master Table window opens.

17. Enter the new table name and click **OK**.

   A dialog window confirms that the data has been posted.
Verifying Import Files

To verify import files, perform the following steps:

1. From the Functions menu, select Import File Verification.
   The Import File Verification window opens.

2. After data has been successfully imported, each import definition contains a valid file name in the Import File Name (IMFILE) field and a value in the Current File Timestamp (FILECURTS) field.

Importing Data from Tivoli Decision Support for OS/390

DSNTIAUL is a sample program delivered with DB2 that unloads data from DB2 tables into sequential files.

For information about the DSNTIAUL program, refer to the DB2 Installation Guide.

A SQL sample statement is provided that uses the CHAR and DECIMAL functions to output data fields stored in DB2 as FLOAT. This allows the product to read the numerical values using the Double type (Double Floating Point).

For information about the CHAR and DECIMAL functions, refer to the DB2 SQL Reference.

To import data from the Accounting Feature of Tivoli Decision Support for OS/390 into the Accounting Workstation Option, perform the following steps:

1. Run the DSNTIAUL program to unload the required DB2 table.
2. Use the SQL option of this program to select the desired fields from the input table.
3. To unload data from the BILLED_DATA table of the Accounting Feature into a sequential file, use the following sample SQL parameter with the DSNTIAUL program:

   ```sql
   LOCK TABLE PRM1.BILLED_DATA IN SHARE MODE;
   SELECT SMF_ID, BP_ID, CU_ID, AC1, AC2, AC3, AC4, AC5, DATE, PERIOD_NAME, CHARGE_TYPE, SUBSYSTEM_ID, CHAR(DECIMAL(CPU SECONDS V,16,4)), CHAR(DECIMAL(CPU SECONDS P,16,4)), CHAR(DECIMAL(CPU SECONDS A,16,4)), CHAR(DECIMAL(TAPE EXCP V,16,4)), CHAR(DECIMAL(TAPE EXCP P,16,4)), CHAR(DECIMAL(TAPE EXCP A,16,4)), CHAR(DECIMAL(DISK EXCP V,16,4)), CHAR(DECIMAL(DISK EXCP P,16,4)), CHAR(DECIMAL(DISK EXCP A,16,4)), CHAR(DECIMAL(PRINT LINES V,16,4)), CHAR(DECIMAL(PRINT LINES P,16,4)), CHAR(DECIMAL(PRINT LINES A,16,4)), CHAR(DECIMAL(TAPE MOUNTS V,16,4)), CHAR(DECIMAL(TAPE MOUNTS P,16,4)), CHAR(DECIMAL(TAPE MOUNTS A,16,4)), CHAR(DECIMAL(PAGES PRINTED V,16,4)), CHAR(DECIMAL(PAGES PRINTED P,16,4)), CHAR(DECIMAL(PAGES PRINTED A,16,4)), CHAR(DECIMAL(DASD MCHARACTERS V,16,4))
   ```
CHAR(DECIMAL(DASD_MCHARACTERS_P,16,4)),
CHAR(DECIMAL(DASD_MCHARACTERS_A,16,4)),
CHAR(DECIMAL(SESSION_KCHARACTERS_V,16,4)),
CHAR(DECIMAL(SESSION_KCHARACTERS_P,16,4)),
CHAR(DECIMAL(SESSION_KCHARACTERS_A,16,4)),
CHAR(DECIMAL(MISC_A,16,4))
FROM PRM1.BILLED_DATA;

4. Use FTP or a functionally equivalent program to move the unloaded sequential file to a file server accessible to the Accounting Workstation Option.

5. Create an Import Definition.  
   Tip: Importing sequential data to the Accounting Workstation Option requires a record layout. The DSNTIAUL program output provides a record layout of the unloaded file in DD reference SYSPUNCH. Use this information to define an Import Definition. A sample Import Definition, named DRLSBLDA, is provided with the Accounting Workstation Option to read the BILLED_DATA table of the Accounting Feature and should match the data produced by the sample SQL statement shown in Step 3.

6. Define the service mapping data in the Accounting Workstation Option Rate Table (ACTIVE).

7. Import the text file.

**Special Processing for Import Definition (DRLSBLDA)**

The utilization and revenue data stored in the BILLED_DATA table of the Accounting Feature for the Host is stored in segments. Each segment contains 3 fields containing utilization, price and amount billed for each type of service. For example, CPU seconds are recorded using these fields:

- CPU_SECONDS_V (Sum of CPU seconds)
- CPU_SECONDS_P (Price of CPU seconds)
- CPU_SECONDS_A (Amount for CPU seconds)

The BILLED_DATA table contains a separate segment for each of the following types of service:

- CPU_SECONDS
- TAPE_EXCPS
- DISK_EXCPS
- PRINT_LINES
- TAPE_MOUNTS
- PAGES_PRINTED
- DASD_MCHARACTERS
- SESSION_KCHARACTERS
- MISC (only 1 field for amount)

The Accounting Workstation Option does not store this data in these same segments. The data is transposed during import processing such that 1 record in the BILLED_DATA table containing 9 segments becomes 9 Ledger records, each with a different Service value. Each segment (type of service) must be mapped to a Service.

Edit the Rate Table (ACTIVE) and add each type of service to an existing Service value. A pre-defined set of Services are provided each mapped to a segment in the BILLED_DATA table. In the following example shown, CPU_SECONDS is mapped
to the CPU AWO Service:

Use these mappings as provided, or modify them as required. Any data segments in the BILLED_DATA table that are not mapped to Service values are ignored during import processing.
Exporting tables

To create an Export Definition, perform the following steps:

1. From the Functions menu, select Export.
   The Export window opens:

   ![Export Window](image)

   1. From the Export Definitions list box, select an existing export definition, or click New to create a new export definition.
   
   **Tip:** Export definition names can contain between 1 and 8 characters.

   2. In the Database list box, select the database containing the table to export.
   3. In the Table list box, select the table to export.
   4. Click Next.
       **Tip:** The output file type can be fixed width or delimited text. Fixed width is the format required by the Accounting Feature for the Host.

2. From the Export Definitions list box, select an existing export definition, or click New to create a new export definition.

   ![Export Definitions List](image)
If the output file type is fixed width, the following Export Wizard window opens:

6. In the **Size** field, specify the maximum size of each field.
7. Check the result of your selections in the Preview Output Table list box.
8. Click **Next**.
The final Export window opens:

9. In the Selected Fields list box, deselect any fields that are not to be exported.
10. Click Save Def button to save the existing export definition.
11. Click the Export button to export the file.
Chapter 7. Working with Data

This chapter describes the tools provided for working with data and how to use them, for example, to allocate costs, calculate charges and assign ownership to billable items.

Defining Selection Criteria

You can define selection criteria for most functions. Use selection criteria whenever you want to process only a subset of the records in the input file. This increases the flexibility of each function and can improve efficiency. For example, if you want to perform a function against records that have a specific service, you can define criteria to select all records that have a service value of ABC. You can also create compound criteria using boolean logic. For example to select records that have a service of ABC and department of XYZ.

A Criteria button on most function opens the Criteria window. Use the Criteria window to create selection criteria interactively, without the need to program in SQL or Structured Query Language. You can open the Criteria window from most functions.
Creating New Selection Criteria

Tip: When you create selection criteria, remember that AND logic requires all conditions to be true whereas OR logic requires only one of the conditions to be true.

To define selection criteria for a function, perform the following steps:

1. From any of the apply function windows, except the Apply Sequence window, click Criteria.

The Criteria window opens:

2. From the Field Name list box, select a field to include in the criteria.

   Tip: This list box shows all fields in the input table you selected in the Apply Function window.

3. From the Operator list box select an operator.

4. To enter a value type the value directly in the Value box.

   Tip: To display possible values, click List Possible Values and select a value from the list box.

5. Click And into Criteria.

   The selection criteria, in SQL syntax, are listed in the Criteria box.

6. To create compound criteria, repeat steps 2 through 4.

   Tips: Use the And Into Criteria and Or Into Criteria as follows:
   - Use And into Criteria to insert an AND between each part of the selection criteria.
   - Use Or into Criteria to insert an OR between each part.

   Edit, save and delete the criteria as follows:
   - To edit the criteria, click inside the Criteria box and make any required edits.
   - To save these criteria for later use, click the Save icon.

The Save SQL File window opens.
Type a name for the SQL file in the File name box and click **Save**.

- To delete the criteria and start over, click **Clear**.

7. When the selection criteria are complete, click **OK**.

**Working with Saved Selection Criteria**

To work with saved selection criteria, perform the following steps:

1. From any of the apply function windows, except the Apply Sequence window, click **Criteria**.

   The Criteria window opens:

   ![Criteria Builder](image)

   2. Click the **Open** icon.

   The Open SQL File window opens.

   3. Select an SQL file and click **Open**.

   The Criteria window opens showing the previously saved selection criteria in the Criteria box.

   4. If you need to add additional logic to the selection criteria, repeat the following steps as required:

   a. From the Field name list box, select a field to include in the criteria.

      **Tip:** This list box shows all fields in the input table you selected in the Apply Function window.

   b. From the Operator list box select an operator.

   c. To enter a value either type the value directly in the Value box, or click the List Possible Values button. A list of each unique value of the selected field is now displayed in the list box. Select one of the values.

   d. Click either the **And into Criteria** or **Or into Criteria** button.

   5. To delete the criteria and start over, click the **Clear** button.

   6. To edit the criteria, click inside the Criteria box and make any required edits.

   7. To save these criteria for later use, click the **Save** icon.

   The Save SQL File window opens.

   8. Type a name for the SQL file in the File Name box and click **Save**.
9. When the selection criteria are complete, click **OK**.

### Interim Ledgers

Interim ledgers are used as a backup so that you can reverse the changes a function makes to the active expense or revenue ledger. When functions are executed interactively and you have selected an active ledger, you are always prompted to create an interim ledger first. Creating an interim ledger takes longer, but means that you can reverse any changes if required. In the previous release of the product, an interim ledger was always created before any function was executed against an active ledger. You now have the option of creating an interim ledger or not. Although the creation of an interim ledger is no longer required, it is still strongly recommended.
Using Rate Tables to Map Services to Rates

Rate tables are used with the Apply Rate Table function to map services values to rates and to calculate charges. The Apply Rate Table function matches the service value in the selected rate table to the service value in the input table (normally a ledger) and populates the corresponding rate field in the input table. The charges field is then calculated by multiplying the quantity and rate fields.

Applying a Rate Table

To apply a rate table, perform the following steps:

1. From the Functions menu, select Apply Rates.
   The Apply Rates window opens:

   ![Apply Rates Window]

   2. Select a ledger from the Input Table list box.
   3. Select a Rate Table from the Rate Table list box.
   4. To use selection criteria with this apply function, click Criteria.
      For more information about selection criteria, see “Defining Selection Criteria” on page 69.
   5. To save the SQL code that is executed by this function, including any selection criteria defined, click Save SQL.
      The Save SQL File window opens.
   6. Type a file name and click Save.
   7. To run the function, click Execute.
      If your input table is the active expense or revenue ledger, a dialog window opens to prompt if you want to create an interim ledger.
   8. To create an interim ledger, click Yes.
Using Lookup Tables to Map Fields

Lookup tables are used with the Apply Lookup Table function to map fields in a table. For example, you could use a lookup table to populate the name field in a table from the userid field.

Applying a Lookup Table

To apply a lookup table, perform the following steps:

1. From the Functions menu, select Apply Lookup.
   The Apply Lookup window opens:

2. Select a table from the Input Table list box.
3. Select a Lookup Table from the Lookup Table list box.
4. To use selection criteria with this apply function, click Criteria.
   For more information about selection criteria, see “Defining Selection Criteria” on page 69.
5. To save the SQL code that will be executed by this function, including any selection criteria defined, click Save SQL.
   The Save SQL File window opens.
6. Type a file name and click Save.
7. To run the function, click Execute.
   If your input table is the active expense or revenue ledger, a dialog window opens to prompt if you want to create an interim ledger.
8. Click Yes if you want to create an interim ledger.
Using Allocation Tables to Distribute Numerical Values

Allocation tables are used with the Apply Allocation Table function to distribute numerical data across records based on a percentage. The Apply Allocation Table function takes each record of the input table (normally a ledger) and matches it to a record in the allocation table based on a common field. If the fields match, new records are placed in the input table based on the percentage specified in the allocation table. You select which numerical fields that will have the percentages applied to them.

**Tip:** This function causes one record in the input table to become multiple records after the function is complete. For example, suppose the Allocation Table specifies that department ABC be allocated across departments DEF and XYZ at 50% each. After the Apply Allocation Table function is complete, the record containing department ABC is no longer in the table. Instead, departments DEF and XYZ appear, each with 50% of the numerical values of the record for department ABC.

Applying an Allocation Table

To apply an allocation table, perform the following steps:

1. From the Functions menu, select **Apply Allocation**.
   
The Apply Allocation window opens:

2. Select a table from the Input Table list box.
3. Select an allocation table from the Allocation Table list box.
4. To select the numerical fields to be allocated by percentage, click the **Select Fields** icon.
   
The Select Fields window opens.
5. Double click each field to be selected.
6. When all fields have been selected, click **OK**.
7. To use selection criteria with this apply function, click **Criteria**.
   
   For more information about selection criteria, see "Defining Selection Criteria" on page 69.
8. To save the SQL code that will be executed by this function, including any selection criteria defined, click **Save SQL**.
   
The Save SQL File window opens.
9. Type a file name and click **Save**.
10. To run the function, click **Execute**.
If your input table is the active expense or revenue ledger, a dialog window opens to prompt if you want to create an interim ledger.

11. Click Yes if you want to create an interim ledger.

Adding User Records to a Ledger

Direct charge tables are used with the Apply Direct Charge Table function to add user defined records directly into a revenue ledger. If the current period value falls within the start and end periods specified in the direct charge table, the Apply Direct Charge Table function copies the record into the selected ledger.

Applying a Direct Charge Table

To apply a direct charge table, perform the following steps:
1. From the Functions menu, select Apply Direct Charge.
   The Apply Direct Charge window opens:

   ![Apply Direct Charge Window](image)

   2. Select a revenue ledger from the Ledger list box.
   3. Select a direct charge table from the Direct Charge Table list box.
   4. To use selection criteria with this apply function, click Criteria.
      For more information about selection criteria, see "Defining Selection Criteria" on page 69.
   5. To save the SQL code that will be executed by this function, including any selection criteria defined, click Save SQL.
      The Save SQL File window opens.
   6. Type a file name and click Save.
   7. To run the function, click Execute.
      If your input table is the active expense or revenue ledger, a dialog window opens to prompt if you want to create an interim ledger.
   8. Click Yes if you want to create an interim ledger.
Applying Multipliers to Numerical Data

Factor tables are used with the Apply Factor Table function to apply a multiplier to numerical fields in a table. This function can be used to apply a CPU normalization rate, calculate discounts and surcharges, calculate taxes and perform currency exchanges. This function gives you the option of directly updating the data, or of creating additional records which can be appended to the input table.

Applying a Factor Table

To apply a factor table, perform the following steps:

1. From the Functions menu, select **Apply Factor**.

   The Apply Factor window opens:

   ![Apply Factor Window](image)

2. Select an input table from the Input Table list box.
3. Select a Factor Table from the Factor Table list box.
4. To select the numerical fields to which the factor is to be applied, click the **Select Fields** icon.

   The Select Fields window opens.
5. Double-click each field to be selected.
6. Click **OK** when all fields are selected.
7. Select either **Update Existing Data** or **Append Data**.

   **Tip:** If you select **Append Data**, select a Service value for the new records from the Service list box.

   If you selected **Append Data**, you can summarize the new records before they are added to the input table. To summarize the new records, perform the following steps:

   a. Click **Summarize Results By**.
b. To select fields to summarize, click the Select Fields icon.
   The Select Fields window opens.
c. Double-click it each field to be selected.
d. Click OK when all fields are selected.

8. To use selection criteria with this apply function, click Criteria.
   For more information about selection criteria, see “Defining Selection Criteria” on page 69.

9. To save the SQL code that will be executed by this function, including any selection criteria defined, click Save SQL.
   The Save SQL File window opens.

10. Type a file name and click Save.

11. To run the function, click Execute.
    If your input table is the active expense or revenue ledger, a dialog window opens to prompt if you want to create an interim ledger.

12. Click Yes if you want to create an interim ledger.
Assigning Sequence Numbers to Groups of Data

The Apply Sequence Number function is used apply a unique sequence number to groups of data in a ledger. This unique sequence number can be referenced as an invoice number, a report number or used with queries to easily identify groups of data.

Applying Sequence Numbers

To apply a sequence number, perform the following steps:

1. From the Functions menu, select Apply Sequence.

   The Apply Sequence window opens:

   ![Apply Sequence Window](image)

2. Select a ledger from the Ledger list box.
3. To select the fields to be sequenced on, click the Select Fields icon.

   The Select Fields window opens.
4. Double click each field to be selected.
5. Click OK when all fields are selected.
6. To select the sequence start number, type a value in the Sequence Start box.
7. To select an amount to increase each sequence number, type a value in the Increment box.
8. To run the function, click Execute.

   If your input table is the active expense or revenue ledger, a dialog window opens to prompt if you want to create an interim ledger.
9. Click Yes if you want to create an interim ledger.
Creating User SQL Procedures

User SQL procedures can be defined and executed against data within Accounting Workstation Option tables. Use the SQL Editor in the Accounting Workstation Option to develop, save and run your own SQL procedures interactively.

Creating a New SQL Procedure

To create a new SQL procedure, perform the following steps:
1. From the Functions menu, select SQL. The SQL Editor window opens:

```
DELETE * FROM ledger_active WHERE DATASRC='LABOR'
```

2. Type your own SQL procedure in this window.
3. To save the SQL procedure, click the Save procedure icon and type a name.
4. Click Save.
5. To execute this SQL procedure, click the Run icon.

Working with Saved SQL Procedures

To work with saved SQL procedures, perform the following steps:
1. From the Functions menu, select SQL. The SQL Editor window opens:

```
DELETE * FROM ledger_active WHERE DATASRC='LABOR'
```

2. Click the Open Procedure icon.
3. Select the procedure and click the Open.
4. To execute this SQL procedure, click the Run icon.

Closing the Accounting Period

The final task in closing your accounting period is to perform the Finalize Ledger function. This function copies the active ledger to an historical ledger and the empties the active ledger in preparation for beginning a new period.
Finalizing a Ledger

To finalize a ledger, perform the following steps:

1. From the Functions menu, select Finalize Ledger.
   The Select Ledger Type window opens:

   ![Select Ledger Type Window]

   2. Select either the Revenue or Expense ledger type and click OK.

   3. The Finalize Ledger window opens:

   ![Finalize Ledger Window]

   4. In the Options box:
      a. Select Delete all interim ledgers if you want the function to delete all of
         the interim ledgers for this ledger type.
      b. Select the ledgers you want to empty.

   5. In the Export box, select the active or historical ledger type for export.

   6. To run the function, click Execute.
Reversing the Finalize Ledger Function

The Finalize Ledger function affects more than one table. If required, you can reverse the results of the function with the Undo Finalize function. This function copies the most recently created historical ledger to the active ledger.

**Tip:** If you emptied other ledger tables, they will remain empty after this function is complete.

Reversing the Finalize Ledger Function

To reverse the Finalize Ledger function, perform the following steps:

1. From the Functions menu, select *Undo Finalize.*
   
   The Select Ledger Type window opens:

   ![Select Ledger Type](image)

   2. Select the ledger type and click **OK.**
   3. To confirm the operation, click **OK.**

 Updating Budget Tables with Revenue or Expense Data

The Apply Actuals function is used to update records in a budget table with data from a revenue or expense ledger. This is helpful in comparing budgeted numbers to actual revenue or expenses. The Apply Actuals function requires a budget table and a ledger as input.

**Tip:** This function updates the ACT_QNT, ACT_RATE and ACT_AMT fields in the selected budget table if the input table is a revenue ledger. If the input table is an expense ledger, only the ACT_AMT field is updated.

Applying Actuals to a Budget

To apply actuals to a budget, perform the following steps:

1. From the Functions menu, select Apply Actuals. The Apply Actuals window opens:

   ![Apply Actuals](image)

   2. Select a ledger from the Input Table list box.
   3. Select a budget from the Budget list box.
   4. To use selection criteria with this function, click Criteria. For more information about selection criteria, see “Defining Selection Criteria” on page xx.
   5. To save the SQL code that will be executed by this function, including any selection criteria defined, click Save SQL. The SQL File window opens.
6. Type a file name and click Save.
7. To run the function, click Execute.

Distributing Values from a Group of Records to Other Records

The Apply Percentage Distribution function is used to apply values from one group of records to other records based on a percentage. The Apply Percentage Distribution function takes a single value, summed from records in the input table (normally a ledger) and distributes it across records in the distribution table based on a percentage.

Tip: This function first sums the totals field in the totals input table to get a single numerical value called the sum total. Then it sums the distribution field from the distribution table to get a single numerical value called the distribution total. Next, in the distribution table, it divides the distribution field by the distribution total to get the distribution percentage. Finally the sum total is multiplied by the distribution percentage and the result is stored in the result field in the distribution table.

Applying Percentage Distribution

To apply a percentage distribution, perform the following steps:
1. From the Functions menu, select Apply Percentage Distribution. The Apply Percentage Distribution window opens:

2. Select a table from the Totals Input Table list box.
3. Select a field from the Totals Field list box.
4. To use selection criteria with the totals input table, click Criteria. For more information about selection criteria, see "Defining Selection Criteria" on page xx.
5. Select a table from the Distribution Table list box.
6. To select fields to group the distribution table, click the Select Fields icon. The select Fields window opens:

7. Double click each field to be selected.
8. When all fields have been selected, click OK.
9. Select a numerical field from the Distribution Field list box.
10. Select a numerical field from the Result Field list box.
11. To use selection criteria with the totals input table, click Criteria. For more information about selection criteria, see "Defining Selection Criteria" on page xx.
12. To save the SQL code that will be executed by this function, including any selection criteria defined, click Save SQL.
13. Type a file name and click Save.
14. To run the function, Click Execute. If your distribution table is the active expense or revenue ledger, a dialog window opens to prompt if you want to create an interim ledger.
15. Click Yes if you want to create an interim ledger.
Chapter 8. Analysis and Reporting

This chapter describes the analysis and reporting tools and how to use them to analyze and report charge back data in the master and local database.

Query Builder

Use the Query Builder to create and save query definitions to analyze data from either the local or master databases.

The Query Builder features include:
• Data Filtering
• Data Summarization
• Aggregate Functions
• Table Joins
• Sorting
• Criteria Builder

Query definitions are saved as files of type .QRD. The results of each query execution are saved in the master database. You can view saved queries and query results in the Data Explorer or Query Explorer.
Creating a Select Query

To create a select query, perform the following steps:

1. From the Analysis menu, select Query Builder. The Database Type window opens:

   ![Database Type Window](image1)

2. To create the select query for the required database, select the database and click OK. The Query Builder window opens:

   ![Query Builder Window](image2)

3. To create a query of type SELECT:
   a. Select the value SELECT in the Query Type list box.
   b. Type a query name in the Query Name input box. This name is used to save this query definition.
   c. Click Next.
The Tables tab opens:

![Query Builder Image]

4. To select one or more input tables, click **Add Table**.
The Add Tables window opens.

5. If multiple tables are selected, perform the following steps to join them together:
   a. To create a join between the selected tables, click **Create Join**
The Join Tables window opens:

b. Select 2 tables from the table list.
c. Select a join field.
d. Select a join type in the Join Type list box.
e. To add the join to the query, click **OK**.

The Tables tab opens and shows the join expression in the Join Expression display box.
6. Click the Fields tab and add one or more fields to the query.

7. If required, specify an aggregate function to be applied to any numeric fields by performing the following steps:
   a. Select the field in the Query Fields list.
   b. Select an aggregate function in the list box labeled Total.
   c. If required, repeat Steps 7a. and b.
   d. Click Next.

8. In the Sort tab, perform the following steps to add one or more sort fields to the query:
   a. Select each required field.
   b. Selected its order from the Sort Order list box.
   c. If required, repeat Steps 8a. and b.
   d. Click Next.
9. If the query requires a criteria statement, perform the following steps in Criteria:
   a. Click Create to open the Criteria window.
   b. Click Next.

10. In the SQL tab, your query is complete and the SQL generated from your query is displayed in this window.
Tip: To save the query, click **Save Definition**. To make changes to the query, click **Back**.

11. To run the query, click **Execute**.
   The query results are displayed in a separate window.

12. When query results are displayed, you can click **Save As Local Table** on the toolbar (next to the **Print** button) to retain the results of the query.

   **Tip:** Query results are saved as a table in the Master database. The saved table name consists of the prefix **query** and the name you provided in the query definition. Query results can be viewed in the Data Explorer in the Analysis branch.
Trending

Trend files are constructed from two or more historical revenue or expense ledger files. Revenue trends are built using utilization (QUANTITY) and Revenue (CHARGES) data summarized by user selected fields. Expense trends are built using expense (EXPENSES) data summarized by user selected field.

The keys can include:
- Any custom fields
- Service category (SERVCAT)
- Service (SERVICE)
- Data source (DATASRC)

Trend files allow for more informative reporting and are used as input to the Forecast function.

Creating a Trend

To create a trend, perform the following steps:
1. From the Analysis menu, select Trends.
   The Ledger Type window opens:
   ![Select Ledger Type](image1)
   2. Select the required trend type.
   3. Click OK. The Select Trend Table window opens:
   ![Select Trend Table](image2)
4. Click **New** to create a new trend file. The Create Trend window opens:

![Create Trend Window](image)

5. To specify the range of the trend, select the first and last ledgers in the First Ledger and Last Ledger list boxes.

6. Use the field picker button to select one or more fields to summarize the trend:

![Select Fields Window](image)

7. Specify the column sequence in the Column Sequence option section.

8. To save the SQL code that is executed by this function, including any selection criteria defined, click **Save SQL**.

   The Open SQL program window opens.

9. Type a file name and click **Save**.

10. Click **Execute**.
Forecasting

The Forecast function uses data from Revenue Trend files to construct data forecasts. The data in forecast files can be used during the rate setting process.

The Forecast function features include:
- Linear regression
- Growth
- Standard or graduated growth

Creating a Forecast

To create a forecast, perform the following steps:

1. From the Analysis menu, select Forecasts.
   
   The Select Forecast Table window opens:

   ![Select Forecast Table](image1)

   2. Click New to create a new forecast.
      
      The Create New Forecast window opens:

      ![Create New Forecast](image2)

   3. Select a trend file to be used as input from the Select Trend list box.
   4. Click Next.
The Create New Forecast window displays the number of historical periods available in the selected trend file:

5. Specify the number of periods to be forecasted in the Forecast Periods input box.
6. Click Next.
7. Specify a growth factor to be applied to the utilization data in the input trend or specify a factor table which contains growth factors in the Apply Factor Table list box.
8. Select a forecast method.

**Tips:** Supported methods include:

- Standard. The standard method applies the growth factor equally to all forecast values. For example, if 6 months is forecast with a (standard) growth of 5%, then 5% are added to each of the 6 forecast utilization values.

- Graduated. The graduated method applies the growth factor as a gradually increasing amount to all forecast values. For example, if 6 months is forecast with a (graduated) growth of 5%, then an increasing amount of growth is applied to each of the 6 forecast utilization values until 5% growth is achieved in the 6th value.

9. Click **Execute**.
Text Reports

The Reports dialog can be used to create and save report definitions.

The Reports dialog features include:
- Grouping
- Sub-Totals
- Aggregate Functions

Creating a Report

To create a report, perform the following steps:

1. From the Analysis menu, select Text Reports.
   The Text Reports window opens:

   ![Text Reports Window]

2. Click the New Report Definition icon to create a new report.
3. Select the data source which contains the input table for the report.

   **Tip:** The master database is AWO20_MASTER. The local database is AWO20_LOCAL.

4. Select a table from the Input Table list box.

5. Click OK to save the report.

6. When the report has been saved, click the **Edit Report Definition** icon to specify your report settings.
7. Click the General tab to set report options like alignment and the number of columns and rows per page:

![General Tab Example]

8. Click Edit Title to specify up to 10 title strings.

9. Click Edit Footer to specify up to 10 footnote strings.

10. Click the Fields tab to select fields to be displayed in your report:

![Fields Tab Example]

11. Select one or more fields from the Available Fields list box as Detail Fields in your report.

12. If required, select one or more fields from the Available Fields list box as Group-By Fields in your report.
13. Click the Layout tab to specify field formatting options for each field in your report:

![Layout tab in a report configuration window](image)

14. If required, you can change the title and other layout options for each field, as appropriate.
15. When you have finished editing the report options, click **Apply** to preview the report in the Text Reports window:

![](image)

16. Click the **Print Report** icon to print the report.

---

**Cube Reports**

The Cube Reports dialog can be used to create and save cube, or cross-tabular, report definitions.

The Cube Reports dialog features include:
- Pivoting
- Drill-down
- Filtering

**Creating a Cube Report**

To create a cube report, perform the following steps:
1. From the Analysis menu, select Cube Reports.
2. The Cube Reports window opens:

3. Click the New Report Definition icon to create a new cube report. The Data Definition window opens:

4. Select the data source that contains the input table for the report.
   
   **Tip:** The master database is DB_MASTR. The local database is DB_LOCAL.

5. Select Table under Dataset.

6. Select a table in the Table list box.
7. Click OK. The Properties window opens to the Layout tab:

![Layout Tab](image)

8. Click the Retrieve Fields button. The All Fields list will contain all fields in the input file.

9. Select fields for the Page Fields, Column Fields, Row Fields and Data Fields by clicking and dragging the field from the All Fields list.

10. Click the Fields tab to specify captions and formats of how the fields are displayed on the report.

![Fields Tab](image)

11. Click the Preferences tab to specify alignment of columns and options.

![Preferences Tab](image)

12. Click the Page Setup tab to specify how the report will look when printed.

![Page Setup Tab](image)

13. When you have finished editing the report options, click the Apply button to preview the report in the Cube Reports window.
14. Click the OK button. The report will display in the Cube Report window.

15. Click the Save Definition icon to save the cube report definition.
16. Click the Edit Report Definition icon to make changes to any of the report settings.
17. Report settings can also be changed within the report by dragging and dropping fields between rows, columns and page fields.
   Tip: When making changes within the report, remember to click the Save icon to make your change permanent if required.
18. Row fields can be expanded or contracted within the report by clicking on the + or - next to the field.
19. Page, column and row fields can be filtered by clicking on the down arrow to the right of the field name.
20. Click the Print Report icon to print the report.

---

**Charts**

The Charts dialog can be used to create and save chart definitions. Charts can be created, modified and saved as either a JPG or BMP image. If the Chart Definition is saved, the chart can be created and the image saved as part of a batch script.

The Chart dialog provides support for the following types of charts:
- Line Charts
- Bar Charts
- Horizontal Bar
- Area
- Point
- Pie
- Fast Line

**Creating a Chart Definition**

To create a chart definition, perform the following steps:
1. From the Analysis menu, select Charts.
2. The Charts window opens:

3. Click the Add or Edit Data Series icon to create a new series for this chart.

4. The Chart Series window opens:

5. Click the Add button. The Chart Gallery window opens:

6. Select the chart type from the list. Click OK. The Chart Series window refreshes with the new series shown. Click the Data button to add data for
this series. The Series Data Source window opens:

7. Select ODBC from the list of Data Source list. Click the Edit button to select a table. The Data Source window appears:

8. Select the data source that contains the input table for the Chart.

   **Tip:** The master database is DB_MASTR. The local database is DB_LOCAL.

9. Select a table from the Table list under Dataset. Optionally, you can create SQL code to define a table.

10. Click OK. The Series Data Source window refreshes with the data source information.

11. Under Display Data, select the fields for this series on the chart. Click OK. The Charts window should refresh and display the series on the chart.

12. Click the Title button. The Change Series Title window displays:
13. Type a name for this series and click OK. The Chart Series window displays.
14. Click the Edit Chart button. The Chart Editor displays with the Chat, Axis and Title tab visible:

Tip: Whenever a change is made in the Chart Editor, it is instantly reflected in the Chart window. This allows you to see what affect each change has before deciding to save the chart definition.

15. Titles and Labels can be defined for the right, left, top bottom and depth axes. Click each axis under the Select Axis to change the title and label.

16. Click the Chart tab and then the Title tab. The Chart Editor window refreshes with the Chart and Title tabs visible:

17. Type the chart title and make format changes to the title.
18. Click the Chart tab and then the Footnote tab. The Chart Editor window refreshes with the Chart and Footnote tabs visible:

19. Type the chart footnote and make format changes to the footnote.

20. Click the Chart tab and then the Legend tab. The Chart Editor window refreshes with the Chart and Legend tabs visible:

21. Set these options to change to the way the chart legend displays chart.

22. Click the Series tab. The Chart Editor window refreshes with the Series and Format tabs visible:
23. Set these options to change to the way this series displays chart.

24. Click the Series tab and then the General tab. The Chart Editor window refreshes with the Series and General tabs visible:

![Chart Editor window with Series and General tabs visible]

25. This tab contains additional options for displaying the series.

26. Click the Series tab and then the Marks tab. The Chart Editor window refreshes with the Series and Marks tabs visible:

![Chart Editor window with Series and Marks tabs visible]

27. This tab contains options for the marks on this series.

28. Once this series is defined correctly, close the Chart Editor window. The Chart Series window appears. To add another series, repeat this checklist beginning with the step for adding a new series.

29. After all series have been defined and the chart is formatted correctly, close the Chart Series window. Click the Save Chart Definition icon to save this chart definition.

30. Click the Edit Chart Definition icon to make changes to any of the chart settings.

31. Click the Add or Edit Data Series to add, edit or delete a chart series.  
   Tip: When making changes within the report, remember to click the Save icon to make your change permanent if required.

32. Click the Save Chart as Graphic icon to save the chart as either a JPG or BMP image.
33. Click the Copy Chart Graphic to Clipboard icon to copy the chart to your clipboard.

Tip: Once the chart image is in your clipboard, it can easily be pasted into another Windows application.

34. Click the Print Chart icon to print the chart.

**Income Analysis**

The Income Analysis function formats revenue and expense data into a results table structured like an income statement. Revenue and expenses are summarized and stated separately by user selected fields. A net income record is provided as the last record of the table. The results can be viewed within the Data Explorer under the Analysis branch. These tables can be used to produce income statement reports.
Performing an Income Analysis

To perform an income analysis, perform the following steps:

1. From the Analysis menu, select Income and click New.

   The Create Income Analysis window opens:

   ![Create Income Analysis Window]

2. Set the Select Data option to Current Period or Prior Period.
   If you select the Prior Period option, select a reporting period using the list box labeled Prior Period.

3. Set the Options to Include Percentages.
   If you include percentages the results table contains a column labeled PERCENT. This is the percentage value of the total revenue or expense for the stated line item.

4. Use the State Revenue By list box to select how revenue should be summarized and stated on the results table.

5. Use the State Expenses By list box to select how expenses should be summarized and stated on the results table.

6. Click Execute.
   If the process completes successfully, a message window displays that the income analysis has been created.
   The table can be viewed within the Data Explorer under the Analysis branch.
**Profit and Loss Analysis**

The Profit and Loss Analysis function states revenue and expense data by a selected field common to both revenue and expense ledgers (that is, SERVCAT, SERVICE) and calculates a profit/loss value (revenue minus expense). A profit/loss column labeled “PL” provides the balance of revenue minus expense for each line item. The analysis can state values for the current period, a selected prior period or in a trended format. The results can be viewed within the Data Explorer under the Analysis branch.

**Performing a Profit and Loss Analysis**

To perform a profit and loss analysis, perform the following steps:

1. From the Analysis menu, select Profit Loss and click New.
   The Create Profit Loss window opens:

   ![Create Profit Loss Window](image)

   2. Set the Select Data option to Current Period, Prior Period or Trended.
      If you select the Prior Period option, select a reporting period using the list box labeled Prior Period. If you select the Trended option, then set the First Period and Final Period list boxes.
      When using the Trended version, the first selected period must be older than the final selected period. Only periods containing both revenue and expense data is shown in the period list boxes.

   3. Use the Report Profit Loss By list box to select how the data should be summarized and stated on the results table.

   4. Click Execute.
      If the process completes successfully, a message window displays that the profit loss analysis has been created.
      The table can be viewed within the Data Explorer under the Analysis branch.
Unit Cost Analysis

The Unit Cost Analysis function states revenue and expense data by a selected user field (that is, SERVCAT, SERVICE) and calculates a unit cost for both revenue and expense. A revenue per unit column labeled "UNIT_REV" provides the revenue collected per unit (QUANTITY). An expense per unit column labeled "UNIT_EXP" provides the expense recorded per unit. The analysis can be stated for the current period, a selected prior period or in a trended format. The results can be viewed within the Data Explorer under the Analysis branch.

Performing a Unit Cost Analysis

To perform a unit cost analysis, perform the following steps:

1. From the Analysis menu, select Unit Cost and click New.
   The Create Unit Cost window opens:

   ![Create Unit Cost Window]

   2. Set the Select Data option to Current Period, Prior Period or Trended.
      If you select the Prior Period option, select a reporting period using the list box labeled Prior Period. If you select the Trended option, then set the First Period and Final Period list boxes.
      When using the Trended version, the first selected period must be older than the final selected period. Only periods containing both revenue and expense data is shown in the period list boxes.

   3. Use the Report Unit Costs By list box to select how the data should be summarized and stated on the results table.

   4. Click Execute.
      If the process completes successfully, a message window displays that the unit cost analysis has been created.
      The table can be viewed within the Data Explorer under the Analysis branch.
Budget Actual Analysis

The Budget Actual Analysis function merges and summarizes budget, revenue and expense data by user fields (that is, SERVCAT, SERVICE). The analysis can be stated for the current period, a selected prior period or in a trended format. The results can be viewed within the Data Explorer under the Analysis branch.

Performing a Budget Actual Analysis

To perform a budget actual analysis, perform the following steps:

1. From the Analysis menu, select Budget Actual and click New. The first window of three opens:

2. Select an input budget file from the list box labeled Select Budget.
3. Set the State Data By option to select Units or Dollars.
   The Units option reports budgeted units from the BUD_QNT field.
   The Dollars option reports budgeted dollars from the BUD_AMT field.
4. Set the Include Data option to include Revenue, Expense or Revenue and Expense.
5. Click Next.
The second window of three opens:

6. Set the Select Data option to Current Period, Prior Period or Trended.
   If you select the Prior Period option, select a reporting period using the list box labeled Prior Period. If you select the Trended option, then set the First Period and Final Period list boxes.
   When using the Trended version, the first selected period must be older than the final selected period.

7. Click Next.
   The third and final window of three opens:

8. Update the State Budget Actual list box by checking each field to be included in the analysis. Each selected field is be used to sort and summarize the budget, revenue and expense data.

9. Click Execute.
If the process completes successfully, a message window displays that the budget actual analysis has been created. The table can be viewed within the Data Explorer under the Analysis branch.

Revenue Recovery Analysis

The Revenue Recovery Analysis function reports utilization or revenue data summarized by user fields (that is, SERVCAT, SERVICE) and calculates the change in recovered utilization or revenue from the prior period. The analysis also provides a historical trend for reference purposes. This data is useful in tracking revenue recovery from period to period at a product, service or organizational level. Unexpected changes in recovered revenue must be identified and may require additional research. The results can be viewed within the Data Explorer under the Analysis branch.

Performing a Revenue Recovery Analysis

To perform a revenue recovery analysis, perform the following steps:
1. From the Analysis menu, select Revenue Recovery and click New. The Create Revenue Recovery window opens:

   ![Create Revenue Recovery Window]

2. Specify a period value in the list box labeled Report Revenue Starting with Period. This value controls the amount of historical trended data provided in the results table. The current and prior periods are always included.
3. Update the State Recovery By list box by checking each field to be included in the analysis. Each selected field is used to sort and summarize the utilization or revenue.
4. Set the State Data option to Units for utilization or Dollars for revenue.
5. Check the Include Percent Change box to add the CHANGE column to the results table.
6. Click **Execute**.

   If the process completes successfully, a message window displays that the revenue recovery analysis has been created.

   The table can be viewed within the Data Explorer under the Analysis branch.
Chapter 9. Managing Data

This chapter describes the tools for managing the data within the database, such as copying tables, removing data from tables, creating and restoring from interim ledgers, and building indexes.

Summarizing Ledgers

Data within a ledger can be summarized to collapse multiple records into a single record. This is helpful in reducing the size of the ledger and making it easier to manage and use. The Ledger Summarization function summarizes data in ledgers. A ledger can be summarized in place or written to a new ledger.

Summarizing Data in a Ledger

To summarize data in a ledger, perform the following steps:

1. From the Functions menu, select Data Management, Ledger Summarization.

The Summarize Ledger window opens:

2. Select a ledger from the Input Ledger list box.
3. Select a ledger from the Output Ledger list box.
4. Select either the Summarize all ledger fields box or the Summarize selected fields box.

Tip: If you checked the Summarize selected fields box, perform the following steps:
   a. Click the Select fields icon to select the summarization fields. The Open SQL program window opens.
   b. To select each field, double-click it.
   c. Click OK when all fields are selected.

5. To save the SQL code that is executed by this function, including any selection criteria defined, click Save SQL.

The Save SQL File window opens.
6. Type a file name and click Save.
7. To run the function, click **Execute**.
   If your output ledger is the active expense or revenue ledger, a message dialog opens, prompting if you want to create an interim ledger.
8. Click **Yes** if you want to create an interim ledger.

### Removing Data from Ledgers

Data can be removed from a ledger based on the value of the data source, service or entry time fields with the Remove Ledger Data function. This is useful for removing invalid or incomplete data, especially during testing.

#### Removing Data from a Ledger

To remove data from a ledger, perform the following steps:

1. From the Functions menu, select **Data Management**, then **Remove Ledger Data**.
   The Remove Ledger Data window opens:

   ![Remove Ledger Data Window](image)

   - **Ledger:** ledger_active
   - **Data Source:** LABOR
   - **Service:**
   - **Entry Time:**

2. Select a ledger from the Ledger list box.
3. Select the required record selection process.
4. If you checked the Select Data Source option, the Data Source list box now shows all unique values of the data source field in the ledger you selected. Select the value of data source for the records to be deleted.
   If you checked the Select Service option, the Service list box now shows all unique values of the service field in the ledger you selected. Select the value of service for the records to be deleted.
   If you checked the Select Entry Time option, the Entry Time list box now shows all unique values of the Entry Time field in the ledger you selected. Select the value of Entry Time for the records to be deleted.
5. To save the SQL code that is executed by this function, click **Save SQL**.
   The Save SQL File window opens.
6. Type a file name and click **Save**.
7. To run the function, click **Execute**.
   If your output ledger is the active expense or revenue ledger, a message dialog opens, prompting if you want to create an interim ledger.
8. If you want to create an interim ledger, click **Yes**.
Maintaining Indexes

Indexes can improve performance of the product, particularly in queries and reports. Use the Build Indexes function to create and delete table indexes.

Using Indexes

Indexes (or keys) are used on tables to sequence data for faster retrieval, or they are used for data constraining or validation. Accounting Workstation Option tables require keys (unique indexes) on tables in order to allow editing. If an Accounting Workstation Option table does not have a key, the edit functions are disabled for that table.

In the Accounting Workstation Option, tables created from the Maintain menu (rate tables, allocation tables, etc.) are created with primary keys to ensure data integrity and enable editing. Several other tables created by the Accounting Workstation Option, like ledger and budget tables for example, are created without keys. This is intentional, as these tables are usually bulk loaded from external sources. The presence of a key during this bulk load would have an adverse effect on application performance.

However, at times it does become necessary for the user to edit a ledger or budget table directly. In this case, the Accounting Workstation Option provides a function for the user to create and manage indexes for selected tables. Once an index is created for a table, the edit functions will be enabled for the table. See the section "Maintaining Indexes" for help adding an index to a selected table.

Creating an Index

To create an index for a table, perform the following steps:

1. From the Functions menu, select Data Management, then Indexes.
   The Database Type window opens.

2. Select the required database type and click OK.
   The Indexes window opens:

   ![Indexes Window](image)

3. Select an input table from the Input Table list box.
   Each index for the selected table is displayed in the Indexes list box.
4. Click Add to create a new index.
The Create Index window opens.

![Create Index Window](image)

5. Type an index name in the Index Name input box.
6. Select the index attributes.
7. To select one or more fields to be indexed, click the Select Fields icon and click OK.
8. To save the indexes definition, click Close.
Copying Tables to and from Databases

Use the Copy Table function to copy tables to and from the master and local databases.

Copying a Table

To copy a table, perform the following steps:

1. From the Functions menu, select Data Management, then Copy Table.

   The Copy Table window opens:

   ![Copy Table Window](image)

2. Select an input database and table in the Input section.
3. Select an output database and table in the Output section.
4. Select a Copy Option.
5. Click Copy to copy the table.

Interim Ledgers

Interim ledgers are used as a backup so that you can reverse the changes a function makes to the active expense or revenue ledger. Interim ledgers are created from either ledger_active or expense_active and always contain the same fields as the ledger they are created from.

When functions are executed interactively and you have selected an active ledger, you are always prompted to create an interim ledger first. However, you may want to create an interim ledger without executing a function, such as when you are executing user written SQL procedures or editing a ledger.
Deleting Interim Ledgers
To delete interim revenue or expense ledgers, perform the following steps:
1. From the File menu, select Maintenance, Delete Interim Ledgers.
The Ledger Type window opens:

```
Select Ledger Type

Interim Ledger Type
- Revenue
- Expense

OK Cancel
```

2. Select the interim ledger type to be deleted and click OK.
A dialog window opens to prompt if you want to delete all interim ledgers of
the selected type.
3. To delete the interim ledgers, click Yes.

Restoring an Active Ledger from an Interim Ledger
To restore an active ledger from an interim ledger, perform the following steps:
1. From the Functions menu, select Data Management, then Restore Interim.
The Ledger Type window opens:

```
Select Ledger Type

Interim Ledger Type
- Revenue
- Expense

OK Cancel
```

2. Select the interim ledger type to be restored and click OK.
The Restore Interim window opens:

```
Restore Interim

INTERIM (Revenue)
interim_003
interim_002
interim_001

Restore Cancel
```

3. To restore the active ledger, select the required interim ledger and click Restore.
Database Compacting

During standard use of the software, a database can become fragmented, resulting in inefficient use of disk space. Compacting the database makes a copy of the database and rearranges database file storage on disk.

If you are using Microsoft Access, perform this procedure on a regular basis.

Compacting a Database

To compact a database, perform the following steps:
1. From the File menu, select Maintenance, then Compact/Backup.

The Compact/Backup window opens:

2. To compact the local database, click Compact in the Local database section.
3. To compact the master database, click Compact in the Master database section to compact the master database.

Tip: This option is available only if the master database is a Microsoft Access database.

Database Backup

You can maintain as many backup copies of your database as desired. Perform this process on a regular basis. Use the Compact/Backup function to create backups for Microsoft Access databases.

Backups of other database types must be managed by your database administrator.

Backing up a Database

To back up a database, perform the following steps:
1. From the File menu, select Maintenance, then Compact/Backup.
The Compact/Backup window opens:

2. To back up the local database, perform the following steps:
   a. Click **Backup** in the Local database section.
   b. Specify a location and file name for the backup local database.
3. To back up the master database, perform the following steps:
   a. Click **Backup** in the Master database section.
   b. Specify a location and file name for the backup master database.
   
   **Tip:** This option is available only if the master database is a Microsoft Access database.

**Activity Log**

The product records all activity that alters data in the master database to an Activity Log for audit purposes. Each record in the log shows the following:

- Function name
- Date and time of execution
- User who performed the function
- Login and logout activity

The activity log is stored in the master database as the activity_log table. The Empty Activity Log functions deletes the contents of the activity log. Monitor the size of the activity log and clear it periodically to reduce its size.

**Emptying the Activity Log**

To empty the activity log, perform the following steps:

1. From the File menu, select **Maintenance**, then **Empty Activity Log**.
   A dialog window opens to prompt if you want to empty the selected activity log table.
2. Click **OK** to empty the activity log.
Chapter 10. Automating Repetitive Tasks

Use batch scripts to run multiple functions in a single script instead of running each function interactively. This feature provides automation and makes the product easier to use. Each supported function behaves the same when executed interactively or in batch mode. This feature is often used for tasks that are always performed repeatedly in the same way and in the same sequence; for example, a month or year end process.

Batch script definitions are stored in the Batch Scripts folder.

Creating or Editing a Batch Script

To create a new batch script or edit an existing one, perform the following steps:

1. From the Maintain window, select Batch Scripts.
   The Batch Scripts window opens:

   ![Batch Scripts window]

2. To create a new batch script, click the New Batch Script icon.
   To edit an existing batch script, click the Open Batch Script icon.
When you open an existing script, the **Batch Scripts** window opens, showing all defined steps:

![Batch Scripts Window](image)

3. To change the sequence of steps in a batch script, select the step and click **Move Up** or **Move Down**.

4. To create a new step, click **Add**.

The Batch Functions window opens:

![Batch Functions Window](image)

5. Select a function from the Functions list box and click **Add**.

6. After adding a step to a script, click **Edit** to edit the function parameters.

The Batch Parameters window opens.

**Tip:** The required parameters are different for each supported batch function.
7. Click OK.
Chapter 11. Publishing Data Reports to an Intranet Site

This chapter describes the process of publishing data, reports and documents to an intranet web site. Once data, reports, and documents are defined to an intranet site, users can view them using only their internet browser. The Accounting Workstation Option data can also be edited directly from a browser. User access to the data can be secured at the table, column, record and user level.

Creating an FTP Profile

FTP Profiles are used to specify and save the parameters necessary for transferring files via FTP. When this information is saved in an FTP Profile, it can be used with multiple Publish Profiles.

To create an FTP Profile, perform the following steps:

1. From the Maintain menu, select FTP Profiles. The FTP Profiles window opens with only the General tab enabled.

2. Click New to create a new profile. The Save FTP Profile window opens:

3. Type a name for this profile and click Save. The FTP Profiles window returns with the Advanced and Firewall tabs enabled.

4. Specify the connection information for this FTP Profile.
5. Click the Advanced tab. The FTP Profiles window refreshes with the Advanced tab visible:

![FTP Profiles window with Advanced tab]

6. Optionally change the Advanced settings on this tab.
7. Click the Firewall tab. The FTP Profiles window refreshes with the Firewall tab visible:

![FTP Profiles window with Firewall tab]

8. Optionally change the Firewall settings on this tab.
9. Click Save to save the FTP Profile.

---

**Creating a Publish Profile**

Documents are published to an intranet site using Publish Profiles. The Publish Profile contains parameters detailing which files will be published, the source and destination locations for the files and the number of versions to be kept on the intranet site. Publish Profiles are executed with a Batch Script Publish function.

To create a Publish Profile, perform the following steps:
1. From the Maintain menu, select Publish Profiles. The Publish Profiles window opens with only the General tab enabled:

![Publish Profiles window with General tab enabled](image)

2. Click New to create a new profile. The Save Publish Profile window opens:

![Save Publish Profile window](image)

3. Type a name for this profile and click Save. The Publish Profiles window returns with the Transfer and Files tabs enabled.

4. Highlight the profile and click the Transfer tab. The Publish Profiles window refreshes with the Transfer tab visible:

![Publish Profiles window with Transfer tab visible](image)

5. Select a Transfer Type for this profile. To publish via FTP, select an FTP Profile from the list. To publish via a site, select the Site from the list. To publish via email, type a list of email addresses, separated by a comma, or click the Address Book icon to select from your existing addresses.
6. Click the Files tab. The Publish Profiles window refreshes with the Files tab visible:

7. Specify the source file, document folder, file name, transfer type and the number of versions you want to publish.

8. If you selected Email as the transfer type, click the Message tab. The Publish Profiles window refreshes with the Message tab visible:

9. Optionally type the subject of the email and the text to be placed in the body of the email.

10. Click Save to save the Publish Profile.

Creating an Intranet Site

A fully functional Intranet Site can be created to view Reports and Documents and to view and edit tables.

To create an Intranet Site, perform the following steps:
1. From the Maintain menu, select Intranet. The Intranet Explorer window opens:

![Intranet Explorer window](image1)

2. Highlight the Site node, right click and select New Site. The New Intranet Site window opens:

![New Intranet Site window](image2)

3. Type a name for this site and click OK. The Intranet Explorer window refreshes with the new site listed under the Sites node.

4. Highlight the branch for this Site, right click and select Edit/View. The Site window opens to the General tab:

![Site window General tab](image3)

5. Select the Publish Method for this Site. If the Publish Method is FTP, select an FTP Profile from the list.

6. Select a Target directory to contain the folders for this Site.
7. Specify the URL that will be used to access this site. This URL is for memo purposes only and can be left blank.

8. Specify the Global Site Features for this Site. These parameters control the features that will be available to users on this Site. Note that permissions to individual tables and reports are specified at that level. These parameters turn on or off the features available to the site overall.

9. Specify the Language that will be used on this Site. An Intranet site can be published in a different language than was selected during the installation of the software. Information on the Intranet Site can be displayed in any of the supported languages.

10. Click the Security tab. The Site window refreshes with the Security tab visible.

11. Specify the security options for this Intranet Site including an Email address that will be displayed on the Login page for questions or problems with the site.

12. Click the Options tab. The Site window refreshes with the Options tab visible.

13. The parameters on the Options tab can be used to control the performance of the Intranet Site, especially if very large table or reports will be defined.
14. Click the Home Page tab. The Site window refreshes with the Home Page tab visible in Edit mode.

15. Specify the HTML code to display on the Home Page of this Intranet Site. Click on Preview to view how the text will actually display on the Intranet Site.

16. Click the Help Page tab. The Site window refreshes with the Help Page tab visible in Edit mode.

17. Specify the HTML code to display on the Help Page of this Intranet Site. Click on Preview to view how the text will actually display on the Intranet Site.
18. Click the Advanced tab. The Site window refreshes with the Advanced tab visible in Edit mode.

![Site window with Advanced tab visible](image)

19. Specify the database type and data source connection information for this site.

20. Click Save to save the Site Definition. A Site Changes Saved confirmation message appears. Click OK. The Update/Initialize Site window appears:

![Update/Initialize Site window](image)

21. Select Initialize Site and click OK.

22. The Site Initialization complete confirmation window displays. Click OK.

Creating Users

Users are defined to restrict access to the Intranet Site, to Reports and Tables on the site and to specific data within Reports and Tables.

To create a User, perform the following steps:
1. From the Maintain menu, select Intranet. The Intranet Explorer window opens:

![Intranet Explorer window](image)

2. Highlight the Users node, right click and select Edit/View. The Edit Table window opens to the Intranet_User table:

![Edit Table window](image)

3. Click the Lock/Unlock Grid icon to enable editing of this table.
4. Type in a User and Password for this user. The remaining columns are optional and are for information purposes only.
5. Click off the row being edited and then close the window to save the changes.

---

**Creating Categories**

Categories are used to group reports and tables on the Intranet Site. Categories enables users to quickly locate related information in reports and tables.

To create a Category, perform the following steps:
1. From the Maintain menu, select Intranet. The Intranet Explorer window opens:

2. Highlight the Categories node, right click and select Edit/View. The Edit Table window opens to the Intranet_Category table:

3. Click the Lock/Unlock Grid icon to enable editing of this table.
4. Type a Description for this Category. The CATID field is automatically generated.
5. Click off the row being edited and then close the window to save the changes.

---

**Defining Tables to an Intranet Site**

Tables are defined to an Intranet Site with Table Definitions.

To create a Table Definition, perform the following steps:
1. From the Maintain menu, select Intranet. The Intranet Explorer window opens.

![Intranet Explorer Window](image.png)

2. Expand the Sites node and then expand the Site. Highlight the Tables node, right click and select Add New. The Intranet Table window opens:

![Intranet Table Window](image.png)

3. Type a Description, select a Source Table and select a Category for this Table Definition. Click Save. The Intranet Explorer window refreshes with the new Table Definition listed under the Tables node for this Site.
4. Highlight the Table Definition, right click and select Edit/View. The Table window opens with the General tab visible:

![Table Definition Window]

5. Select the Table Options for this Table Definition. These options control whether records can be added or deleted from the table.
6. Click the Presentation tab. The Table window refreshes with the Presentation tab visible:

7. Select the order the records in the table will be displayed by clicking on the Select Fields icon. Specify Edit Criteria to restrict the information that is displayed in the table by rows. SQL code and be typed into the Edit Criteria field or click the Build button to create SQL syntax with the Criteria Builder. For more information about selection criteria, see "Defining Selection Criteria" on page xx.
8. Click the Events tab. The Table window refreshes with the Events tab visible:

9. Specify SQL code to execute after a record is updated (Update Event) or after a new record is added (Add New Record Event). SQL Events can be used to populate additional fields in a record.
10. Click the Columns tab. The Table window refreshes with the Columns tab visible:

11. For each column, use the Move Up and Move Down to icons to select the order the columns will appear in the table. Select a row and click the Edit icon. The Table Columns window displays with the General tab visible:
12. For this column, specify the Default value. Click the Column Options tab. The Table Columns window refreshes with the Column Options tab visible:

![Column Options Window]

13. For this column, specify the options for how this column will be displayed. Click the Presentation tab. The Table Columns window refreshes with the Presentation visible:

![Presentation Window]

14. For this column, specify the Presentation options for how this column will be displayed. Click OK. Click the Notes tab. The Table window refreshes with the
15. For this Table, specify Notes that will be displayed at the top of the table. Click the Permissions tab. The Table window refreshes with the Permissions
16. For this Table, Double click a User to grant access. Click Save and then click Close.

**Defining Reports to an Intranet Site**

Tables are defined to an Intranet Site with Table Definitions.

To create a Table Definition, perform the following steps:
1. From the Maintain menu, select Intranet. The Intranet Explorer window opens.

2. Expand the Sites node and then expand the Site. Highlight the Reports node, right click and select Add New. The Intranet Report window opens:

3. Type a Description, select a Report Table and select a Category for this Report Definition. Click Save. The Intranet Explorer window refreshes with the new Report Definition listed under the Reports node for this Site.
4. Highlight the Report Definition, right click and select Edit/View. The Report window opens with the General tab visible:

5. Select the Report Options for this Report Definition. These options control whether totals will be calculated and shown on this report.
6. Click the Style tab. The Table window refreshes with the Style tab visible:

7. Select the background color, alignment and gridlines options for this report.
8. Click the Titles/Footer tab. The Report window refreshes with the Titles/Footer tab visible:

![Report window with Titles/Footer tab visible]

9. Optionally specify title, subtitle, and footer text for this report.
10. Click the Columns tab. The Report window refreshes with the Columns tab visible:

![Columns Tab](image)

11. Click the Add Columns icon. The Add Report Columns window displays:

![Add Report Columns](image)

12. Double click each column that should appear on this report. Click OK when all report columns are selected. Click the Conditional Format tab. The Report
For this report, specify up to three conditional formats. This can be useful in easily identifying fields that exceed a given criteria. Specify the first condition on the Condition 1 tab. Click the Condition 2 tab to specify a second conditional format and Condition 3 to specify a third. Conditional formatting is optional.
14. Click the Permissions tab. The Report window refreshes with the Permissions tab visible:

15. For this Report, Double click a User to grant access. Click Save and then click Close.
Chapter 12. Navigating the Accounting Workstation Option Web Site

This chapter describes the requirements for how to configure, publish and navigate the Accounting Workstation Option web site.

Getting Started

There are several steps required to generate an Accounting Workstation Option web site and making it available on your company intranet.

Software Requirements

The software requirements for publishing an Accounting Workstation Option web site are:

- Microsoft NT Server 4.0 or Microsoft Windows 2000 Server
- Microsoft Internet Information Server (IIS), Version 5.0 (or greater)

Implementation Tasks

Perform the following tasks to prepare to publish an Accounting Workstation Option web site:

1. Establish a Virtual Directory on the IIS server that will be hosting the Accounting Workstation Option web site.

2. The Accounting Workstation Option product will generate a fully configured web site to be published in the established virtual directory. The content of the generated web site include HTML, ASP, CGI and graphics files organized into several directories. There are 2 methods that may be used to publish the Accounting Workstation Option web site to the virtual directory. The Accounting Workstation Option can be configured to use FTP or a direct file copy function to publish the files to the web site. Follow the steps in the section “Creating an Intranet Site” to create and initialize your Accounting Workstation Option web site. This section describes the process for creating, initializing and updating an Accounting Workstation Option web site.

3. Use the Accounting Workstation Option to configure and revise your web site. Changes to the configuration and content of your Accounting Workstation Option web site made using the Accounting Workstation Option Intranet Administration dialog, will be immediately effective. You may want to consider developing both a production and test web site.

The Accounting Workstation Option Web Site Home Page

The Accounting Workstation Option Web Site Home page provides links to each major area of the web site. These links include:

Reports

This feature provides real-time reports directly from your database. Security features allow the product administrator to control data content for each user. The end-user can also filter data and drill-down through reports. Custom user settings can be saved as Favorites for later viewing.
Edit Data
This feature allows the product administrator to enable tables in the database to be viewed and edited via the web.

Favorites
Users can save custom report or edit data sessions for later viewing. Favorites are user specific and can be viewed from the site’s Home page.

Documents
This feature enables the publication of data and reports to the web. All file types are supported. Reports, charts, data extracts and other file types can be stored with multiple versions.

Starting the Accounting Workstation Option Web Site
Once a virtual directory in an IIS server is established and your Accounting Workstation Option product administrator has initialized the web site, you can access the site using a web browser.

Open a web browser and enter the URL defined in IIS to access the Accounting Workstation Option virtual directory. The Accounting Workstation Option home page will be displayed:

Logging In to the Accounting Workstation Option Web Site
Users will be prompted to Login to the Accounting Workstation Option web site when they attempt to access any reports, tables, or documents. The user can
manually login at any time by clicking the Login link on the home page.

Complete the login by entering your Accounting Workstation Option assigned user ID and password.

**Web Reports**

The reports section of the web site can be accessed by clicking the "Reports" link on the home page. The user will be presented with a list of reports authorized for their user ID and grouped by category.

To view a report:
1. Select a category, then double-click a report title to view the report.

2. This will open the report in a new window.

Applying a Report Filter

Use the following steps to apply a filter to an existing report:
1. On the toolbar, select a field name to be used in your filter argument.

2. Select an operator for your filter argument.
3. Enter a value in the input box or click the "List Possible Values" button to select from a list of unique values for the selected field.

4. Select the "AND" or "OR" option to control how the new argument is to be added to the existing filter. This is not required for the first filter argument.

5. Click the "Add Filter" toolbar button to apply the new filter argument.

Adding a Favorite

An Accounting Workstation Option favorite is a shortcut to a selected report or edit with that has been customized with a user-applied filter. The user can then view their favorites from the "Favorites" link on the home page. All favorites are specific to the user that creates them.

Use the following instructions to add a favorite:

1. Open a report for viewing or open a table for edit.
2. Apply any desired filters.
3. Click the "Add Favorite" toolbar button. The "Adding favorite" dialog window will appear:

4. Supply a user-defined title for the favorite. The favorite title defaults to the existing report title.
5. Click "OK" to add the favorite or "Cancel" to cancel the operation.
Accessing Favorites

User favorites can be accessed by selecting the "Favorites" link from the home page.

Each favorite is listed with user-assigned names. View any favorite by clicking the link associated with that favorite.

Favorites can be deleted by clicking the "Delete" icon to the right of the favorite link.

Editing Tables

The "Edit Data" section of the web site can be accessed by clicking the "Edit Data" link on the home page. The user will be presented with a list of tables they are authorized to view and edit.

To view a table:

1. Select a category, then double-click a table description to view the table.
2. This will open the table in a new window.

3. Click the Edit button on the toolbar to begin your edit session. Click the "Save Changes" or "Cancel Changes" when you have completed your changes.

Viewing Documents

The Accounting Workstation Option product publishes documents to the Accounting Workstation Option web site. Documents can be published with single or multiple versions and are organized into a directory structure defined by the Accounting Workstation Option administrator. All document types are supported.

The documents section of the web site can be accessed by selecting the "Documents" link from the Accounting Workstation Option web site home page.

Documents are displayed with a title, size, date and folder location. Files can be selected for view or download using the link named with the file title. Entries
prefixed with a plus (+) sign indicate multiple versions of the document exist. All versions of a document can be viewed by clicking the plus (+) sign icon.

Folders can be navigated using the folder links displayed just above the documents display box.

Web Site Toolbars

The Accounting Workstation Option web site contains two toolbars; a toolbar available during edit sessions and a filter toolbar available during report view and table edit sessions.

Add Criteria to Filter. After a filter argument is constructed, this button adds the newly created criteria to any existing criteria.

Replace Filter. Replaces the existing filter with the newly constructed filter criteria.

Undo Last Filter. Removes only the most recent addition to the filter.

Clear Filter. Clears all filter arguments.
List Possible Values. During the construction of a filter argument, allows the user to select from a list of unique values from the selected field.

Select Value. Once the List Possible Values toolbar function is complete, this function allows the user to select a unique value from the list.

Print. Prints the current contents of the window.

Export to Excel. Exports the current contents of the window to Excel. The filter is applied to the exported data.

Add Favorite. Adds a favorite for the user.

Table View. Displays all records in a tabular view.

Form View. Displays a selected record in form view.

Add New Record. Adds a new record to the table.
Edit Record. Edits an existing record in form view or multiple records in a tabular view.

Save Edit Changes.

Cancel Edit Changes.
Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
500 Columbus Avenue
Thornwood, NY 10594
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not appear.
Trademarks

DB2, DB2 Universal Database, IBM, the IBM logo, Tivoli, Tivoli Enterprise, Tivoli Enterprise Console, AS/400, CICS, IBMLink, IMS, MVS, Netview, OS/390, and z/OS are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.
account data. Information describing a customer. This information, when related to a custom field, can contain e-mail addresses. The data is stored in the accounts database table.

active ledger. A revenue ledger that contains data for the current period. The data is stored in the ledger_active database table.

activity log. An audit trail of every function that has altered data in the active ledger. The data is stored in the activity_log database table.

allocation. The process of distributing quantities, charges and other numerical data on a percentage basis.

allocation table. The database table in which you define the values to be used by the allocation function.

Apply Rate Table function. This function uses a service rate table to map services to rates in a ledger and then calculates charges. See also: service rate table.

batch script. A text file with the extension .mbs that contains instructions for executing multiple functions collectively.

budget tables. Database tables that contain revenue or expense budget data. The data in these tables is compared to revenue or expense data to produce budget versus actual analysis.

charges. The field in ledger tables that contains the product of multiplying the quantity and the rate. This field is updated during the Apply Rate Table function.

compact. A database management function that reduces the space used by a database.

criteria. An SQL WHERE statement that subsets the input data before a function is performed.

criteria builder. A feature that enables you to define selection criteria interactively without the need to program in SQL.

custom fields. Fields that you can add to a ledger and name yourself. These fields can be either numeric or character.

data explorer. A window that displays objects in the database using a Microsoft Windows style interface.

data source. This refers to the DATASRC field in ledgers. By default, this field contains the name of the import definition that resulted in the records being added to the ledger.

direct charge table. A database table containing user records that can be directly added to a ledger.

drill-down. A hierarchical method of viewing data in a table. Each viewing level is a subset of the previous level.

expense table. Data containing expenses incurred by the service provider. This data can be combined with revenue ledger data to produce Profit and Loss reports.

export. The process of copying data out of the database.

export definition. A collection of parameters used to export data from a database table. This information includes where to place the data and what format to store it in. This information is stored in a text file with the extension .exd. By storing the information, you do not need to re-specify all of the information each time an export function is executed.

factor table. A database table that maps an input field to a multiplier, which is then applied to selected numeric fields in a table.

finalize ledger. The process of closing the active ledger for the period. The data in the active ledger is stored in an historical ledger and the active ledger is emptied.

historical ledger. Data from prior periods. These tables are named LGpppppp, where pppppp is the period value of the data within the table. See also: period.

import. The process of loading external data into a database table.

import definition. A collection of parameters used to import data to a database table. This information includes where to find the data and what format it is stored in. This information is stored in a text file with the extension .imd. By storing the information, you do not need to re-specify all of the information each time an import function is executed.

import results. A table in the local database which contains data imported from an external source.

interim ledger. A copy of the active ledger before a function is executed against it. The creation of an interim ledger is optional, but recommended.

local database. A Microsoft Access database that stores user tables. A local database can only be attached to a single master database.
lookup table. A database table used to map one or more input values to one or more output values.

master database. The database containing application data tables. This database can be created in Microsoft Access or Microsoft SQL Server. A master database can only be attached to a single local database.

period. The name assigned to a set of days the user defines as a billing cycle. This value is specified as yyyymm, where yyyy is the year and mm is the month.

post. The process of updating the master database.

query. SQL code to extract selected data from one or more database tables.

query builder. A feature that generates SQL procedures in response to user input. Does not require knowledge of SQL programming.

rate. A numeric representation of a service that is multiplied by the quantity to determine the charges. A single service can have one only rate.

revenue ledger. A database table that contains data for revenue collected from the utilization of services by clients.

service. A term that describes a chargeable unit of work. A service can have only one rate.

service category. The name given to a collection of rates. Each service can be assigned to only one service category.

service rate table. A database table that contains services and rates.

SQL. Structured Query Language.

SQL editor. A tool that enables you to build and edit SQL procedures.

trend. A database table built from multiple historical ledgers that shows a horizontal view of charges over time.
Index

A
accessibility ix
Activity Log clearing 126
Allocation Tables 36 fields in 36
Analysis Forecasting 94 Automation 127

B
Batch Script Creating New 127 books feedback vi online vi ordering vi
Budget Tables 52 fields in 52

C
Charges calculating 73
Close Accounting Period See Functions, Finalize Ledger
Criteria Builder 69 creating new selection criteria 70 working with saved selection criteria 71
Custom Fields 30 creating 30 data types 30 in Budget tables 30 in Expense Ledgers 30 in Revenue Ledgers 30 customer support ix

D
Database backing up 125 Compacting 125 Direct Charge Tables 45 fields in 45

E
Expense Ledgers 27 creating active 29 creating user 29 custom fields in 27 expense_active 28 expense_pdt 28 expense_suspend 28 expense_test 28 historical 28 Expense Ledgers (continued) static fields in 28 Export Definition creating 65

F
Factor Tables 49 Forecasts Creating New 94 Functions Apply Factor Table 77 Apply Lookup Table 74 Apply Rate Table 73 Apply Sequence Numbers 79 Build Indexes 121 Clear Activity Log 126 Compact Database 125 Copy Table 123 Delete Interim Ledgers 124 Finalize Ledger 81 Ledger Summarization 119 Remove Data 120 Restore from Interim 124 Undo Finalize 82

I
Indexes building 121 removing 121 Installation 3 Installing 4 Interim Ledgers 29, 72 creating 30 Deleting 123 fields in 29 restoring from 124

L
Ledger Keys See Custom Fields Ledgers removing data from 120 restoring from Interim 124 summarizing data in 119 Local Database 25 LookAt message retrieval tool vii Lookup Tables 41

M
manuals feedback vi online vi ordering vi Master Database 25 message retrieval tool, LookAt viii

O
online publications ix ordering publications ix

P
Program Requirements 3 publications feedback vi online vi ordering vi

Q
Query Creating 86 Query builder 85

R
Rate Tables 32 fields in 32 rates_active 32 Rates in Rate Tables 32 Removing 8 Reports 97 Creating 97 Revenue Ledgers 25 creating active 27 custom fields in 26 historical 26 ledger_active 25 ledger_suspend 25 ledger_test 25 static fields in 26

S
Service Categories Service Category Table 32 Service Category Table 32 fields in 32 Services in Rate Tables 73 Setup See Installation software support ix SQL Editor creating a new SQL procedure 80 working with saved SQL procedures 80

175
SQL Procedures
   See SQL Editor

T

Tables
   Factor Tables  77
   Lookup Tables  74
   Rate Tables  73

Trend
   Creating New  92
Program Number: 5695-101

Printed in USA